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About  
 
This application is a powerful yet easy-to-use reporting tool. It runs in your web browser and does 

not require any downloads. 

Supported Browsers 

Supported browsers include: 

 Firefox 3+ 

 Internet Explorer 9+ / Edge 

 Google Chrome 

 Safari 

Navigation 

This application consists of two sections. On the left is the Main Menu and on the right are Tabs. 

The Main Menu displays the available reports, folders, and buttons. Tabs can contain the New 

Report Wizard, report outputs, design windows, or help pages. 
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Main Menu 

Through the Main Menu you can: 

 

 Create new reports 

 Search for reports 

 Read report descriptions 

 Run reports  

 Export reports to other types (Excel, PDF, RTF and CSV) 

 Duplicate reports to save time setting up reports that are similar 

 Edit reports 

 Delete reports  

 Schedule reports to be emailed or archived 

 Manage folders and report storage 

Press the splitter  to hide the Main Menu. This is located in the top left corner of the application's 

interface between the Main Menu and the Tabs. 

Tabs 

The right section is made up of tabs containing the New Report Wizard, reports outputs, design 

windows, or help pages. Tabs can be closed by pressing the  to the right of the tab name. 

 

 

Tabs can be rearranged by clicking and dragging them left or right. 
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Creating New Reports 
 
To create a new report, press the New Report Button. This will launch the designer for the selected 

report type. 

 

Types of Reports 

This application has six types of reports. 

 

  ExpressViews – These are a quick way to view your available data in an easy-to-use 

format. The intuitive drag-and-drop interface enables you to create beautiful views with 

minimal effort. For more information, see ExpressView Designer. 

  Express Reports – This simplified report designer enables you to quickly build reports 

with basic layouts and calculations. For more information, see Express Reports. 
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  Standard Reports – This type of report uses an intuitive grid to lay out data and labels. 

Standard reports can provide more complex sections in which to group data and make 

specialized calculations. For more information, see Report Designer. 

  Crosstab Reports – Crosstab reports utilize the Standard Report Designer to create 

reports that may expand both horizontally and vertically based on data. For more 

information, see Crosstabs. 

  Dashboards – This is a canvas for combining and laying out reports, data visualizations, 

images, text and web pages. For more information, see Dashboards. 

  Chained Reports – This type of report compiles multiple reports into a single document. 

For more information, see Chained Reports.  
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ExpressView Designer 

The designer has two parts: The Fields pane and the Design pane. On the left, you can browse 

data fields and add them to the ExpressView. On the right, you can customize your design. 

 

Selecting a Data Field 

The left pane contains all the Data Fields you have access to, sorted by their category. To see all 

the fields in a category, press the  (Expand) button to its left: 

 

The icon to the left of each field indicates the type of data it contains: 

  text 

  numeric 

  date/time 

  other 
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On top is a search bar. To search for a field by name, enter some text into the bar, then press the 

 (Search) button. To clear the search press the  (Clear) button. 

Below the search bar are search filters. To filter for a specific type of data, press the button for that 

data type. Press it again to clear the filter. Only one data type may be filtered at a time. 

Viewing your Data 

The right pane is where you'll view and organize your data. To add a field to the ExpressView, drag-

and-drop it from the Fields pane to the Design pane; Or double-click the field; Or select the field 

and press the  (Add Field) button. 

A new column representing the data from your field will be automatically added to the design. 

You can add as many columns as you like. 

Data Columns 

 

Columns are initially populated with placeholder data. This increases the performance and 

responsiveness of the designer. To see the actual data in the columns, switch the ExpressView to 

Live Mode by pressing the Live Mode switch: 
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In Live Mode, you can see your data, but you can no longer edit the ExpressView. 

Switch it back to Design Mode to see what customizations you can make. 

 

Parts of a Column 

Each data column comprises a header, data, and total. 

Header 

 

On the left side of the header is the header icon / Radial Menu button. 

 This icon will be a different color depending on the level of grouping. 

 Click to open the Radial Menu... 

  

In the middle is the name of the data field. 

 Click-and-drag left or right to change the position of the column. 

 In Live Mode, pressing a group header collapses the group. 

  

On the right side is the Sort indicator. 

 The arrow indicates the direction of the sort: Ascending or Descending. Click to change 

the sort direction. 

 The number indicates the sort priority. A lower number means that a column is sorted 

before the columns with higher numbers. 
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Data 

 

Placeholder data is numbered to indicate the sort direction. 

Total 

 

At the bottom of each column is an aggregate total row. Click here and select from the dropdown 

to indicate how to aggregate the column data. You can select either Count, Sum, Minimum Value 

(Min), Maximum Value (Max), Distinct Count, or Average (Avg) for each group. 

Radial Menu 

 

The Radial Menu is a shortcut for editing columns that puts a suite of context-sensitive tools at an 

easy-to-reach place. 

Using the radial menu, you can: 

 Group and ungroup columns, 

 Change column grouping, 

 Sort by a column, 

 Change sort ordering, 

 Filter by a column, 

 and remove columns, 

  

...all with only a single mouse click! Here's how it works. 

To get started, choose a column, and click, or click-and-hold on the header button: 
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A radial menu for that column will open up right at your mouse cursor. 

 

Each of the four "slices" of the menu represents a different action you can perform on your 

column. Choose an action by moving your mouse over the slice and clicking, or with the menu 

closed, click and swipe over the desired option. 

Options 

 

Group by this column. 

Filter by this column. Adds the data field to the Filters menu so you can add conditions. 

Sort by this column. Switches the sort precedence to the highest level. 

Remove this column from the ExpressView. 

Click in the center to dismiss the menu without making a change. 

Group Options 

The radial menu has some alternative options for a Group column. 
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Move Group precedence up one. If it is a top-level group, move precedence to the bottom. 

Filter by this column. Adds the data field to the Filters menu so you can add conditions. 

Sort Order: Swap the sort direction, Ascending or Descending. 

Ungroup this column. 

Grouping Columns Together 

In an ExpressView, organizing columns into groups is quick and simple. Select the column you 

want to group by pressing the header icon, then select the Group slice in the Radial Menu. 

 

The selected column will automatically be transformed into a group. 
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Each group has its own header and footer, and can be individually collapsed by pressing on its 

header. 

Groups can be stacked multiple levels deep. 
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To ungroup a column, press the header icon, then select the Ungroup slice in the radial menu. 

 

Toolbar 

On top of the Designer is the Toolbar, which contains buttons for all the tasks you'll need when 

using an ExpressView. 

 

 Options 

  Report Info: View and set a Name, Folder, and Description for the ExpressView. 

  Create Copy as Standard Report: Copy the current ExpressView to a new Standard Report. 
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 Save the ExpressView. If it is read-only, save a duplicate. Ctrl-S 

 Expand or Collapse all groups. 

 Refresh all data (Live Mode). Ctrl-R 

 Search the ExpressView. Ctrl-F 

 Live Mode 

This switch acts as a toggle between Live Mode and Design Mode. 

In Design Mode you can create and make changes to the ExpressView. Columns are populated by 

placeholder data. When ExpressViews are created or edited, they open in this mode. 

Read-only ExpressViews cannot be opened in Design Mode. Create a duplicate to edit. 

In Live Mode, ExpressViews are populated by all their data. You can no longer make changes in 

this mode. When ExpressViews are run, they open in this mode. 

 Sorts S 

This button opens the Sorts menu. This menu shows you all the sorts currently active on the 

ExpressView, and lets you change their direction and order of precedence. 

 

Click-and-drag the handles up or down to re-order sorts. 

 

Select asc or desc to specify the sort direction. 

Press  Apply or  OK to save your changes. 
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 Filters F 

This button opens the Filters menu. This menu shows you all the filters currently active on the 

ExpressView. You can add, modify, or remove filters from this menu. 

 

To add a filter to the ExpressView, first open the Filters menu. Then click-and-drag a data field 

from the Fields pane and drop it into the Filters menu. 

 

A filter condition menu will open for the data field. Select an operator from the first dropdown, 

and a value from the subsequent dropdown(s). 
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Click on a filter to expand or collapse the condition menu. 

Press  to remove a filter. 

Press  Apply or  OK to save your changes. 

Sections 

The Filters menu has two sections: 

Meet all of the following conditions 

Meet any of the following conditions 

Filters in the all section are combined together. Data must satisfy all of the filters. 

For example, you may want to view 'Seafood' orders made in the past year. You would add 

filters "CategoryName is EqualTo 'Seafood'" and "OrderDate is GreaterThan '2016-01-01'" in 

this section. 

Filters in the any section are evaluated separately. Data must satisfy any one of the filters. 

For example, you may want to view only records from 'Davolio' and 'Fuller'. You would add 

filters "LastName is EqualTo 'Davolio'" and "LastName is EqualTo 'Fuller'" in this section. 

Click-and-drag the handles up or down to change a filter's section. 
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Express Report Wizard 

The Express Report Wizard is an interactive tool which allows you to quickly create and edit 

Express Reports. 

Navigate between the tabs by clicking on the tab, or by using the  Previous and Next  buttons. 

To save an Express Report, press the  (save) button. 

 

The Express Report Wizard has six sub tabs. The Name, Categories and Layout tabs must be 

completed while the other tabs are optional. 
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Name Tab 

 

In the Name Tab, enter a report name and select which Folder to save the report. 

The report name can be up to 255 characters long. Avoid special characters such as ? : / \ * “ < >. 

A report's description appears at the bottom of the Main Menu when it is selected. You may also 

search by a report's description text. 

You cannot create a report inside a folder that is read-only ( ). 
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Categories Tab 

 
 
In the Categories Tab, select the Data Categories that you would like to have access to on the 

report. It is important to understand two terms: Data Category and Data Field. 

Data Category – A Data Category is a data object that has several attributes. E.g. Orders is a 

category; each order has an ID, a date, a customer, etc. 

Data Field – A Data Field is a single attribute within a category. E.g. Orders.OrderID is numeric 

value that identifies a specific order. 

 To add a Data Category, either drag-and-drop it to the selection pane, or select the 

Category and press  Add or , or double-click the Category. 

 To search for a Data Category or folder, enter text into the search bar. 

 To see the Data Fields in a Data Category, select the Category and press . 

 Check Suppress Duplicates to suppress any repeated records from that Category. 

 To remove a Data Category, press . 



Exago User Guide  

24 Exago Inc. 

Sorts Tab 

 
 
In the Sorts Tab, specify which Data Fields will be used to determine the order of data on the 

report. 

 To sort by a Data Field, either drag-and-drop it to the selection pane, or select the Data 

Field and press  Add or , or double-click the Category. 

 To sort by a Formula, press  Add Formula. To edit an existing formula, press . See 

Sorting by Formula for more information. 

 You can order each sort in Ascending (A-Z, 0-9) or Descending (Z-A, 9-0) order. 

 Use the up ( ) and down ( ) arrows to indicate the sort priority. 

 To remove a sort, press .  
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Filters Tab 

 
 
In the Filters Tab, create statements that will be used to filter the data when you run the report. 

There is no limit to the number of filters that can be defined. Filters can be numeric (up to eight 

decimals) or alphanumeric. 

 To filter by a Data Field, either drag-and-drop it to the selection pane, or select the Data 

Field and press  Add or , or double-click the Data Field. 

 Use the up ( ) and down ( ) arrows to indicate the filter priority. 

 To remove a filter, press . 

 Select the operator (Equal To, Less Than, One Of, etc.) from the operator dropdown. 

 Set the filter value either by entering it manually or by selecting a value from the filter 

dropdown. If the Data Field is a date, the calendar and function buttons can be used to 

select a value. 

 Check Prompt for Value to allow the filter to be modified at the time the report is run. 

 Select AND With Next Filter to require that the selected filter and the one below it both 

evaluate to true. Select OR With Next Filter to require that either one be true. 

 Check Group With Next Filter to specify the precedence of the filters. Filters can be nested 

indefinitely by using the following keyboard shortcuts while a filter is selected: 
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 Ctrl + [ adds an open-parenthesis before the selected filter. 

 Ctrl + ] adds a close-parenthesis after the selected filter. 

 Ctrl + Shift + [ removes an open-parenthesis from before the selected filter. 

 Ctrl + Shift + ] removes a close-parenthesis from after the selected filter. 

Layout Tab 

 
 
In the Layout Tab, select which Data Fields will appear on the report. For each Data Field chosen, 

the report will automatically create a column header and the Data Field. You can add subtotals, 

grand totals, and page header/footers. 

Display Data 

 To place a Data Field on the report, either drag-and-drop it to the selection pane, or select 

the Data Field and press  Add or , or double-click the Data Field. 

 To add blank columns that can be edited manually, press  Add Blank. You can enter text 

into a blank column. 

 Use the up ( ) and down ( ) arrows to indicate the order the Data Fields should appear 

on the report. The Data Field at the top will appear as the leftmost column of the report. 
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 The Summary Function column is used to make subtotals and grand totals. See Subtotals 

and Grand Totals for more information. 

 To remove a Data Field, press . 

For each Data Field in the Sorts tab, a checkbox will appear in the 'Summarize By' box. Using the 

'Summarize By' box you can display subtotals, grand totals, or headers for the values of a Data 

Field. 

Subtotals and Grand Totals 

 To display subtotals, check the box of the Category you want to subtotal. Then, for each 

Data Field you want totaled, select a Summary Function (see below). 

 To display grand totals, check the Grand Total box. Then, for each Data Field you want 

totaled, select a Summary Function (see below). 

  Summary Functions: 

 Sum: Totals the all of the data in the Data Field. 

 Count: Returns the number of rows in the Data Field. 

 Average: Takes the mean of the data in the Data Field. 

 Minimum: Displays the lowest value in the Data Field. 

 Maximum: Displays the highest value in the Data Field. 

 

Data Headers 

To display a header for each value of a Data Field, click on the associated Data Category in the 

'Summarize By' box. Click the Data Category name next to the checkbox, and the Header Menu will 

appear. 

 To include a blank row before each unique value of the selected Data Field, check Add 

space before each unique item. 
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 To include a Header, check Include Header at the beginning. In order to select the text 

that will appear as the header value, use the Header Text dropdown to select a Data Field 

or use the Formula Editor Button ( ) to create a formula. 

 Use the Summarize by each unique dropdown to specify if the header should repeat 

based on a specific Data Field or if it should repeat for all of the keys of a Category.  

 Check Include Total at the end to have a subtotal created for this Category. 

 

Page Header 

 

To display information on the top of each page, check Page Header. Press Page Header and the 

Page Header Menu will appear: 
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 Check Include Title at the top of every page to display the name of the report on each 

page. If an image is also included, use the position dropdown to set where the title should 

appear and the number of columns it should span. 

 Use the Change Image button to upload an image to display at the top of each page. If a 

title is also included, use the Position dropdown to set where the image should appear and 

the number of columns it should span. 

Footers 

 

To display information on the bottom of each page, check Page Footer. Press Page Footer and 

the Page Footer Menu will appear: 
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 Check Include page number at the bottom of every page to display the page number on 

each page. If an image is also included, use the position dropdown to set where the page 

number should appear and the number of columns it should span. 

 Use the Change Image button to upload an image to display at the bottom of each page. If 

the page number is also included, use the Position dropdown to set where the image 

should appear and the number of columns it should span. 

Preview 

 

At the bottom of the Layout Tab, a preview will display how the report will appear based on the 

fields that have been added. You can increase/decrease the size of the preview or hide it 

altogether by dragging the top of the Express Report Designer box. 

Styling Express Reports 

 

The toolbar above the preview can be used to style the Express Report. To utilize this toolbar, 

select the cell(s) in the preview you want to modify, then use one of the following options: 

 Undo/Redo – can undo or redo the last change made. You can also use Ctrl+Z / Ctrl+Y, 

respectively. 
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 Layout Options – see Layout Options for more information. 

 

 Font – see Font for more information. 

 

 Foreground & Background Color – see Color for more information. 

 

 Number/Date Format/Border Color – see Formatting Cells for more information.  

 

  Alignment – see Alignment for more information.  

 

Theme – Quickly style the report using one of the pre-defined themes. 

 

Layout Options 

 

In Layout Options you can hide the detail information and set row shading. 

 Check Suppress Detail Rows to only display Subtotals, Grand Totals, Data Headers & Page 

Headers/Footers. 

 To add row shading press  New and select a color from the color dropdown or enter a 

hex value. 

 Use  and  to change the order of the colors. Press  to remove a color. 

Row Shading is only applied to the detail rows that contain Data Fields. 
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Options Tab 

The Options Tab allows you to control various report settings. 

General Options 

 

 From the Include Setup Info menu, select Top or Bottom to display the data categories, 

sorts, and filters at either the beginning or end of the report. 

 Select which type of Filter menu to display when executing a report that has prompt-for-

value filters. 

 Default – Display the default type of filter execution window. 

 Standard – Display the standard filter execution window. 

 Simple with Operator – Display a simplified filter execution window that only allows 

the operator and value to be changed. 

 Simple without Operator – Display a simplified filter window that only allows the filter 

value to be changed. 

 Check Always Show Filters in Report Viewer to show the filter menu and allow changes 

to be made each time the report is run. 
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Export Options 

 

General Options 

 Use the Default Export Type dropdown to specify the default format for the report. 

 Output types can be disabled by unchecking the respective Allowed Export Types box. 

Report Viewer Options 

 Uncheck Show Grid to disable grid lines. 

 Uncheck Simulate PDF to prevent the report from appearing as though it were on a page. 

Excel Options 

 Check Suppress Formatting to prevent the report formatting from exporting to Excel. 

Page Options 

 Specify the size of the report in the Page Size dropdown. Default is Letter. 

 Set the orientation for the report in the Orientation menu. Default is Portrait. 

 Check Fit to Page Width to scale all columns to fit the width of the page. 
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Advanced Options 

 

In the Advanced Options an Express Report can be converted to a Standard Report. 

 IMPORTANT. This CANNOT be undone. 

 Press Convert Express Report to a standard report to convert an Express Report to a 

Standard Report. 
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New Standard Report Wizard 

The New Standard Report Wizard is an interactive tool which will walk through the process of 

creating a new standard report. All of the selections made in the New Standard Report Wizard can 

be modified in the Report Designer after the report has been created. 

Navigate between the tabs by clicking on the tab, or by using the  Previous and Next  buttons. 

 

The New Report Wizard has five sub tabs. The Name and Categories tabs must be completed 

while the other tabs are optional. 

Name Tab 

 

In the Name tab, enter a report name and select which Folder to save the report. 
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The report name can be up to 255 characters long. Avoid special characters such as ? : / \ * “ < >. 

A report's description appears at the bottom of the Main Menu when it is selected. You may also 

search by a report's description text. 

You cannot create a report inside a folder that is read-only ( ). 

Categories Tab 

 

In the Categories Tab, select the Data Categories that you would like to have access to on the 

report. It is important to understand two terms: Data Category and Data Field. 

Data Category – A Data Category is a data object that has several attributes. E.g. Orders is a 

category; each order has an ID, a date, a customer, etc. 

Data Field – A Data Field is a single attribute within a category. E.g. Orders.OrderID is numeric 

value that identifies a specific order. 

 To add a Data Category, either drag-and-drop it to the selection pane, or select the 

Category and press  Add or , or double-click the Category. 

 To search for a Data Category or folder, enter text into the search bar. 

 To see the Data Fields in a Data Category, select the Category and press . 

 Check Suppress Duplicates to suppress any repeated records from that Category. 

 To remove a Data Category, press . 
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Sorts Tab 

 

In the Sorts Tab, specify which Data Fields will be used to determine the order of data on the 

report. 

 To sort by a Data Field, either drag-and-drop it to the selection pane, or select the Data 

Field and press  Add or , or double-click the Category. 

 To sort by a Formula, press  Add Formula. To edit an existing formula, press . See 

Sorting by Formula for more information. 

 You can order each sort in Ascending (A-Z, 0-9) or Descending (Z-A, 9-0) order. 

 Use the up ( ) and down ( ) arrows to indicate the sort priority. 

 To remove a sort, press .  
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Filters Tab 

 

In the Filters Tab, create statements that will be used to filter the data when you run the report. 

There is no limit to the number of filters that can be defined. Filters can be numeric (up to eight 

decimals) or alphanumeric. 

 To filter by a Data Field, either drag-and-drop it to the selection pane, or select the Data 

Field and press  Add or , or double-click the Data Field. 

 Use the up ( ) and down ( ) arrows to indicate the filter priority. 

 To remove a filter, press . 

 Select the operator (Equal To, Less Than, One Of, etc.) from the operator dropdown. 

 Set the filter value either by entering it manually or by selecting a value from the filter 

dropdown. If the Data Field is a date, the calendar and function buttons can be used to 

select a value. 

 Check Prompt for Value to allow the filter to be modified at the time the report is run. 

 Select AND With Next Filter to require that the selected filter and the one below it both 

evaluate to true. Select OR With Next Filter to require that either one be true. 

 Check Group With Next Filter to specify the precedence of the filters. Filters can be nested 

indefinitely by using the following keyboard shortcuts while a filter is selected: 
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 Ctrl + [ adds an open-parenthesis before the selected filter. 

 Ctrl + ] adds a close-parenthesis after the selected filter. 

 Ctrl + Shift + [ removes an open-parenthesis from before the selected filter. 

 Ctrl + Shift + ] removes a close-parenthesis from after the selected filter. 

Layout Tab  

 

In the Layout Tab, select the Data Fields that will appear on the report. For each Data Field chosen, 

the report will automatically create a column header and place the Data Field in the detail section. 

Additionally, subtotals, grand totals, and a page header/footer can be created. 

Display Data 

 To place a Data Field on the report, either drag-and-drop it to the selection pane, or select 

the Data Field and press  Add or , or double-click the Data Field. 
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 Use the up ( ) and down ( ) arrows to indicate the order the Data Fields should appear 

on the report. The Data Field at the top will appear as the leftmost column of the report. 

 The Summary Function column is used to make subtotals and grand totals. See Subtotals 

and Grand Totals for more information. 

 To remove a Data Field, press . 

For each Data Field added in the Sorts tab, a checkbox will appear in the 'Summarize By' box. Using 

the 'Summarize By' box you can display subtotals, grand totals, or headers for the values of a Data 

Field. 

 

Subtotals and Grand Totals 

 To display subtotals, check the box of the category you want subtotals for in the Summarize 

By box. Then, for each Data Field you want totaled, select a Summary Function. 

 To display grand totals, check the Grand Total box. Then for each Data Field you want 

totaled, select a Summary Function. 

Summary 

Functions 

 Sum: Totals the all of the data in the Data Field. 

 Count: Returns the number of rows in the Data Field. 

 Average: Takes the mean of the data in the Data Field. 

 Minimum: Displays the lowest value in the Data Field. 

 Maximum: Displays the highest value in the Data Field. 

Data Headers 

Each Data Category in the Sorts tab will appear in the 'Summarize By' box. To display a header for 

each value of a Data Field, click on the Data Category name and a Header Menu will appear. 
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 To include a Header, check Include Header at the beginning. In order to select the text 

that will appear as the header value, use the Header dropdown to select a Data Field or use 

the Formula Editor Button ( ) to create a formula. 

 Use the Summarize by each unique dropdown to specify if the header should repeat 

based on a specific field or fields within a Category. 

 Check Include Total at the end to have a subtotal created for this Category. 

Page Header 

 

To display information on the top of each page, check Page Header. Press Page Header and the 

Page Header Menu will appear. 

 

 Check Include Title at the top of every page to display the name of the report on each 

page. If an image is also included, use the position dropdown to set where the title should 

appear and the number of columns it should span. 

 Use the Change Image button to upload an image to display at the top of each page. If a 

title is also included, use the Position dropdown to set where the image should appear and 

the number of columns it should span. 
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Footers 

 

To display information on the bottom of each page, check Page Footer. Press Page Footer and 

the Page Footer Menu will appear. 

 

 Check Include page number at the bottom of every page to display the page number on 

each page. If an image is also included, use the position dropdown to set where the page 

number should appear and the number of columns it should span. 

 Use the Change Image button to upload an image to display at the bottom of each page. If 

the page number is also included, use the Position dropdown to set where the image 

should appear and the number of columns it should span. 
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Preview 

 

At the bottom of the Layout Tab, a preview will display how the report will appear based on the 

fields that have been added. You can increase/decrease the size of the preview or hide it 

altogether by dragging the top of the preview box. 

New Crosstab Wizard 

The New Crosstab Wizard is an interactive tool which will walk through the process of creating a 

new Crosstab report. All of the settings in the New Crosstab Wizard can be modified in the Report 

Designer after the report has been created. 

Navigate between the tabs by clicking on the tab, or by using the  Previous and Next  buttons. 

 

The New Report Wizard has four sub tabs. The Name, Categories, and Layout tabs must be 

completed while the other tabs are optional. 
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Name Tab 

 
 
In the Name tab, enter a report name and select which Folder to save the report. 

The report name can be up to 255 characters long. Avoid special characters such as ? : / \ * “ < >. 

A report's description appears at the bottom of the Main Menu when it is selected. You may also 

search by a report's description text. 

You cannot create a report inside a folder that is read-only ( ). 
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Categories Tab 

 

In the Categories Tab, select the Data Categories that you would like to have access to on the 

report. It is important to understand two terms: Data Category and Data Field. 

Data Category – A Data Category is a data object that has several attributes. E.g. Orders is a 

category; each order has an ID, a date, a customer, etc. 

Data Field – A Data Field is a single attribute within a category. E.g. Orders.OrderID is numeric 

value that identifies a specific order. 

 To add a Data Category, either drag-and-drop it to the selection pane, or select the 

Category and press  Add or , or double-click the Category. 

 To search for a Data Category or folder, enter text into the search bar. 

 To see the Data Fields in a Data Category, select the Category and press . 

 Check Suppress Duplicates to suppress any repeated records from that Category. 

 To remove a Data Category, press . 
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Filters Tab 

 

In the Filters Tab, create statements to filter the data at runtime. 

There is no limit to the number of filters that can be defined. Filters can be numeric (up to eight 

decimals) or alphanumeric. 

 To filter by a Data Field, either drag-and-drop it to the selection pane, or select the Data 

Field and press  Add or , or double-click the Data Field. 

 Use the up ( ) and down ( ) arrows to indicate the filter priority. 

 To remove a filter, press . 

 Select the operator (Equal To, Less Than, One Of, etc.) from the operator dropdown. 

 Set the filter value either by entering it manually or by selecting a value from the filter 

dropdown. If the Data Field is a date, the calendar and function buttons can be used to 

select a value. 

 Check Prompt for Value to allow the filter to be modified at the time the report is run. 

 Select AND With Next Filter to require that the selected filter and the one below it both 

evaluate to true. Select OR With Next Filter to require that either one be true. 
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 Check Group With Next Filter to specify the precedence of the filters. Filters can be nested 

indefinitely by using the following keyboard shortcuts while a filter is selected: 

 Ctrl + [ adds an open-parenthesis before the selected filter. 

 Ctrl + ] adds a close-parenthesis after the selected filter. 

 Ctrl + Shift + [ removes an open-parenthesis from before the selected filter. 

 Ctrl + Shift + ] removes a close-parenthesis from after the selected filter. 

Layout Tab 

 
 
In the Layout Tab, design the Crosstab by moving Data Fields into the Row Header, Column 

Header, and Tabulation Data panels. 
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Row Headers 

Row Headers expand a Crosstab vertically. A Crosstab has a row for each unique value of a Row 

Header. 

E.g. If you were using sales data, you might select Row Headers Category.CategoryName and 

Products.ProductName to provide rows for each product grouped by category. 

 To add a Row Header, either drag-and-drop the Data Field to the Row Header Source 

panel or select the Data Field and press . 

 Use the Formula Editor Button ( ) to insert a formula into the Row Header. 

 Use the Edit Header button ( ) to open the header options menu. 

 

 

In the Header Options Menu, you can: 

 Set a Label for the Row Header. This label will appear at the top of the Crosstab. 

 Select a sorting Method and Direction: 

 

 None – Does not sort the Row Headers. 

 Header Value (Text) – Sorts the Row Header by its values as though they are 

text. 

 Header Value (Number) – Sorts the Row Header by its values as though they 

are numbers. 

 Tabular Totals – Sorts the Row Header by the totals of the Tabulation Data.  

If there is more than one Row Header, the Header Options Menu for the top-most Row Header will 

have Options for subtotals of Tabulation Data. 
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 Select where to display subtotals using the Placement dropdown: 

 

 None – Does not display subtotals. 

 Top – Displays subtotals above the Tabulation Data for each Row Header 

value. 

 Bottom – Displays subtotals below the Tabulation Data for each Row Header 

value. 

 Set a Label for the subtotals. 

 Use the up ( ) and down ( ) arrows to rearrange the order of the Row Headers. 

 To remove a Row Header, press . 

Column Headers 

Column Headers expand a Crosstab horizontally. A Crosstab has a column for each unique value 

of a Column Header. 

E.g. If you were using sales data, you may have the Column Headers Year({Order.OrderDate}) and 

Month({Orders.OrderDate}) to provide columns for each month grouped by year. 

 To add a Column Header, either drag-and-drop the Data Field to the Column Header 

Source panel or select the Data Field and press . 

 Use the Formula Editor Button ( ) to insert a formula into the Column Header. 

 Use the Edit Header button ( ) to open the Header Options menu. 

 

 
 

In the Header Options Menu, you can: 
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 Set a Label for the Column Header to appear at the top of the Crosstab. 

 Select a Sorting Method and Direction: 

 

 None – Does not sort the Column Headers. 

 Header Value (Text) – Sorts the Column Header by its values as though they 

were text. 

 Header Value (Number) – Sorts the Column Header by its values as though 

they were numbers. 

 Tabular Totals – Sorts the Column Header by the totals of the Tabulation Data. 

If there is more than one Column Header, the Header Options Menu for the topmost Column 

Header will have Options for subtotals of Tabulation Data. 

 Select where to display subtotals by using the Placement dropdown. 

 

 None – Does not display subtotals. 

 Left – Displays subtotals to the left of the Tabulation Data for each Column 

Header value. 

 Right – Displays subtotals to the right of the Tabulation Data for each Column 

Header value. 

 Set a Label for the subtotals. 

 Use the up ( ) and down ( ) arrows to rearrange the order of the Column Headers. 

 To remove a Column Header, press . 

Tabulation Data 

Tabulation Data provides information when data exists for both the Column Header and Row 

Header values. 

E.g. If you have a Row Header on Products and a Column Header on the Month, then Tabulation 

Data of Orders.OrderID may use the Count function to display how many orders contained each 

product each month. 

 To add a Tabulation Data Source, either drag-and-drop the Data Field to the Tabulation 

Data panel or select the Data Field and press . 

 Use the Formula Editor Button ( ) to insert a formula into the Tabulation Data. 

 Use the Edit Tabulation button ( ) to open the Tabulation Options menu. 
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In the Tabulation Options Menu, you can: 

 Set a Label for the Tabulation Row to appear at the beginning of each row. 

 Use the Method dropdown to select the summary function to be applied to the 

Tabulation Data. 

 

Summary 

Functions 

 Sum: Totals the all of the data in the Tabulation Data. 

 Count: Returns the number of rows in the Tabulation Data. 

 Average: Takes the mean of the data in the Tabulation Data. 

 Minimum: Displays the lowest value in the Tabulation Data. 

 Maximum: Displays the highest value in the Tabulation Data. 

 None: Displays the value in the Tabulation Data without doing any 

calculations. 

 

 Use the Value dropdown to select how the Tabulation Data should be displayed: 

 Aggregate: Display the result of the selected Method. 

 Percent of Row: Display the result of the selected Method as a percentage of 

the row total. 

 Percent of Colum: Display the result of the selected Method as a percentage of 

the column total. 

 Use the up ( ) and down ( ) arrows to rearrange the order of the Tabulation Data. 

 To remove a Tabulation Data Source, press . 

Crosstab Themes 

The Theme dropdown can be used to quickly style the Crosstab using a predefined theme. Further 

styling can be done in the Report Designer. 
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Crosstab Options 

Settings that affect the entire Crosstab are controlled in the Crosstab Options menu. 

 

Using this menu, you can adjust the following settings: 

General  

 Use the Row Headers Placement dropdown to determine how the Row Headers are 

displayed. 

 Columns – Display the Row Headers in columns from left to right in the order they 

appear in the Row Header Source panel. 

 Hierarchical – Display Row Headers in a hierarchical structure using indentation to 

display their order. 

 Check Repeat Crosstab Header every new page to repeat Row Header labels and Column 

Headers on each new page. 

Grand Total Row 

 To get a total for each column, select Top or Bottom from the Placement dropdown and 

provide a label in the Label text box. 

Grand Total Column 

 To get a total for each row, select Top or Bottom from the Placement dropdown and 

provide a label in the Label text box. 
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Preview 

 
 

At the bottom of the Layout Tab, a preview will display how the Crosstab will appear based on the 

fields that have been added. You can increase/decrease the size of the preview or hide it 

altogether by dragging the top of the preview box. 
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Searching Reports 
 

To search for a specific report, enter your search terms in the search box in the Main Menu. All 

reports that contain one or more of the search terms in their names will appear. 

 

To cancel your search and return to a complete list of reports, press . 

To expand your search to include report descriptions, press  and check Include Description 

(slower). 
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Folder Management 
 

If you do not see a Manage Folders button in the Main Menu, then you do not have folder 

management privileges and should contact your administrator. 

In the Main Menu, press . A dropdown menu will appear: 

 

 

 Add root folder: Add a new folder at the base of the directory. 

 Add child folder: Add a new folder within the selected folder. 

 Rename folder: Rename the selected folder. 

 Delete folder: Delete the selected folder. The folder must be empty. 

A folder marked read-only ( ) cannot be modified. 
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Editing Reports 
 

To edit an existing report: 

On the Main Menu, select the report you want to edit and press , or double-click the report. 

 For ExpressViews, the ExpressView Designer will open to Design Mode in a new tab. 

 For Standard and Crosstab reports, the Report Designer will open in a new tab. 

 For Express Reports, the Express Report Wizard will open in a new tab. 

 For Chained Reports, the Chained Report Wizard will open in a new tab. 

 For Dashboards, the Dashboard Designer will open in a new tab. 

You cannot edit reports marked read-only ( ). You can duplicate a read-only report into an 

unlocked folder and edit the duplicate. 

Report Designer 

The Report Designer can be used to add data, charts, formulas, sorts, filters and many other 

features to a report. 

The Report Designer has three parts: the Design Grid, the Data Menu and the Toolbar. 
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Design Grid 

In the design grid, you can: 

 Add and delete rows, columns, and sections. 

 Enter data fields, text, and formulas. 

 Drag-and-drop fields into different sections, rows, or columns. 

Sections 

 

Sections dictate how the data appears in a report. There are five types of sections: page, report, 

details, group, and repeating group. 

Page Header & Page Footer – The rows in the Page Header section appear at the top of 

every page of a report. Typically, the Page Header section is used to designate column headers for 

a report. The rows in the Page Footer section appear at the bottom of every page of a report. 

Typically, the Page Footer sections are used to display the page number and/or confidentiality 

notices for a report. 

Page Headers and Page Footers are not intended to perform calculations or display data fields. 

For this reason, a Page Header populated with a data field will only return the first line of data in 

that field; a Page Footer will return only the last line of data. 

 

If you are printing a report, remember that Excel output does not have pages. Page Headers will 

appear only once at the beginning of the report. Reports run via the Report Viewer will display 

Page Headers similarly unless Simulate PDF is checked in the Options menu. 
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Report Header & Report Footer – The rows in the Report Header appear at the beginning of 

a report. Typically, these rows display the title of a report. The rows in the Report Footer appear at 

the end of a report. Typically, the Report Footer displays grand totals and summary information 

for the report. 

Detail – The Detail section is the main section of most reports. When a report is executed, the 

Details Section creates a row for each element in the Data Categories. For example, if the Detail 

section contains the Data Field Orders.OrderId, the report will display each Order Id on a separate 

row. 

Group Header & Group Footer – Group Header/Footer sections require a sort on a Data 

Field or formula. The rows in a Group Header section will appear above the Detail section for each 

unique value of the sorted item. Typically, Group Header sections are used to display data as 

labels. For example, a report may contain a Group Header on Orders.OrderDate and display 

Orders.OrderId in the Detail section. The output would display each date with orders that occurred 

on that date below them. 

The rows in a Group Footer section will appear below the Detail section for each unique value of 

the sorted item. Typically, Group Footer sections are used to calculate subtotals. For example, a 

report may contain a Group Footer on Orders.OrderDate which displays the number of orders 

made on each date. 

Repeating Groups – Repeating Groups require a sort on a Data Field or formula. Repeating 

Groups have their own header, details and footer subsections. Repeating Groups should only be 

used when the data has multiple one-to-many relationships and each should be rendered 

completely before the other. 

(E.g. Each Professor can teach multiple classes and advise multiple students. For each 

professor you want to see all the classes they teach and then all the students they advise.) 

Using Sections 

Sections can be added, deleted, modified, moved, and assigned shading. 

Adding Sections 

  

1. Click anywhere in the Section Column. 

2. Hover your mouse over 'Add Section', then select the type of section to add. 

 

Deleting Sections 

 

1. In the Section Column, click on the section to delete. 

2. Press 'Delete Section'. 

 

Modify Sections (Group Header/Footers and Repeating Groups) 
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1. In the Section Column, click on the section to modify. 

2. Press 'Modify Section'. This will bring up a 'Modify Group Section' Menu. 

3. Select the desired Data Field from the dropdown menu. 

4. Press  OK. 

 

Section Shading 

 

1. In the Section Column, click on the section to Shade. 

2. Press 'Section Shading'. This will bring up the Section Shading menu. 

 

 
 

3. Press  New to add a color to the shading. 

4. Click the color box and select a color in the dropdown; Or enter a hex value. 

5. Press  OK. 

Columns and Rows 

Columns and rows of cells can be added, modified, or removed. 

Columns 

 To select a group of columns, hold the SHIFT key and then click the beginning and ending 

column. 

 Non-contiguous columns can be selected by holding the CTRL key and clicking the desired 

columns. 

 A column can be resized by dragging its right edge horizontally. 
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 Clicking on a column (or selected group) will display a menu where you can: 

 
 

o Insert a new column. 

o Delete the selected column. 

o Set all selected column widths to be identical. 

o Hide the selected column. 

o Set Column Info to label the column and/or make it sortable in the Report Viewer. 

Sorting by Columns in the Report Viewer 

While viewing reports in the Report Viewer, a user can click the bar at the top of the report to sort 

by a column. For Express Reports this is handled automatically, but it must be enabled for 

Standard and Crosstab Reports. 

 

To make a column sortable: 

 Click on the column and select 'Column Info…' 

 

 Provide the column with a Label that will appear in the Interactive Report Viewer Dock. 

 From the Sort dropdown select the Data Field to be used for sorting, or provide a formula 

by pressing the formula button ( ). 

Column Sorts are applied AFTER any sorts defined in the Sorts Menu. 
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 Click on the column again to set a default sort direction. 

 

Rows 

 To select a group of rows, hold the SHIFT key, then click the top and bottom rows of the 

area you wish to select. 

 Non-contiguous rows can be selected by holding the CTRL key and clicking the desired 

rows. 

 A row can be resized by dragging its bottom edge vertically. 

 Clicking on a row (or selected group) will display a menu where you can: 

 

 
 

 Insert a new row. 

 Delete the selected row. 

 Set the selected row's height to be automatically controlled. 

 Suppress the selected row from appearing on the report. 

 Insert a page break (See Using Page Breaks) 
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Cells 

Cells are the containers for all the information in a report. Cells may contain text, images, charts, 

or links to other reports. 

 

 To enter text, double-click the cell, and a text field will appear. 

 To select cells, either click the cells or use the arrow keys to toggle from one to the next. 

 Groups of cells can be selected by holding the SHIFT key and clicking on another cell. All the 

cells in between the two will be selected. 

 Non-contiguous cells can be selected by holding the CTRL key and clicking the desired cells. 

 A cell can be copied by holding the CTRL key, then dragging and dropping it into a new cell. 

 Adjacent cells can be merged and unmerged using the Merge/Split Cell buttons in the 

Toolbar: 

 

 
 

Using Page Breaks 

For a Page Break to occur at the beginning of each element of a Data Field, place a page break on 

the top row of the Group Header Section for that Data Field. See Sections for more detail on 

Group Header Sections. 
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Collapsible Rows 

Group Sections can be set to display collapsed by default in the Report Viewer. This causes the 

contents of the section to be suppressed and individually expandable for each change in the 

Header. Collapsible rows are only supported in the Report Viewer. Export formats will ignore 

Collapsible Rows. 

Left-click on an arrow next to a Collapsible Row to expand or collapse the group: 

 

Right-click on an arrow next to a Collapsible Row to see additional display options: 

 

Expand will expand the selected top-level group. (This 

is the same as left-clicking an arrow.) 

Collapse will collapse the selected top-level group. 

The state of the sub-groups is preserved. 

Expand Group will expand the selected top-level 

group and all sub-groups within that group. 

Collapse Group will collapse the selected top-level 

group and all sub-groups within that group. 

Expand All will expand every group and sub-group on 

the page. 

Collapse All will collapse every group and sub-group 

on the page. 
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Creating a Collapsible Row 

To create a Collapsible Row, first open the desired report in the Report Designer. Click on the 

desired row number in a Group Header Section, and select Collapse Rows in the dropdown menu: 

 

 

A Collapsible Row is indicated by an arrow at the bottom right of the row number cell. 

Properties of a Collapsible Row 

Collapsible Rows have the following properties when a report is viewed: 

 Collapsible Rows display as collapsed whenever a report is run or altered using the 

Interactive Report Viewer. 

Collapsed or expanded state cannot be saved to User Report preferences. 

 Page Breaks below a Collapsible Row are ignored. 

 Expanding a Collapsible Row will not alter the Report pagination. 

 

See Sections for more detail on Group Headers Sections. 

See Interacting with the Report Viewer for more information the Interactive Report Viewer. 

Data Menu 

The data menu holds the data that you can put into a report. 
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Adding Data Fields to a Report 

To add a Data Field to a report, select the appropriate Data Category at the top of the menu. Drag-

and-drop the Data Field from the menu to a cell in the Design Grid. 

 

Alternatively, a Data Field can be put into a cell by typing Data Category Name (dot) Data Field 

Name. (E.g. Orders.OrderID). 

To access other Data Categories, see  Data Categories. 

Toolbar 

The toolbar contains the buttons and menus used to modify the report. Modifications can include 

aesthetic formatting, inserting formulas and images, linking reports, and much more. 

The toolbar begins with a dropdown menu. This menu controls changes, such as renaming or 

filtering, that affect the entire report. 
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Saving Reports 

The report can be saved by pressing the save button ( ). The report will also save automatically 

any time it is run or exported. 

Undo/Redo 

Actions can be undone by pressing the undo button ( ) or using the keyboard shortcut Ctrl+Z. 

Undone actions can be redone by pressing the redo button ( ) or using the keyboard shortcut 

Ctrl+Y. 

Font & Alignment Options 

The text of each cell can be formatted using dropdown menus and buttons in the toolbar. A cell or 

multiple cells must be selected for these tools to be used. 

Font  

 Select a font using the font dropdown. Font names appear in the style that they represent. 

 B, I, and U, make the font bold, italicized, and underlined, respectively. 

 Use the  menu to set the font size. 

Color 

 To change the text color, press  and select a color or enter a hex value into the box. Press 

 to revert to the default color. 

 To change the background color, press  and select a color or enter a hex value into the 

box. Press  to revert to the default color. 
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Alignment 

 Text can be aligned to the top, center, or bottom of a cell using the vertical alignment 

buttons. 

 

Text can be centered, justified, or aligned to the left or right of a cell using the horizontal 

alignment buttons. 

 

 The wrap text button ( ) will begin a new line if the text is longer than the width of the cell. 

Formatting Cells 

Press  to open the Format Cells window. The window has three tabs: Number, Border, and 

Conditional. 

Cell formatting can be copied using the Format Paintbrush. Select the format you want to copy, 

press the format paintbrush button ( ), then click the cell you want to apply the formatting to. 

Number 

The Number Tab allows you to set the format of numbers and dates. 

 General: 

o General format automatically applies formatting to cell values. 

 Number: 

o Using the arrows, you can specify how many decimals to display. You can also set 

the symbol to separate decimals from whole numbers. 

o Check Use 1000 Separator to separate every 3 digits. You can set which symbol is 

used to separate digits. 

o Check Use Currency Symbols to have the currency sign appear in front of the 

number. 

o Check Append Percent Sign to have a % appear after the number. 

o Check Blank When Zero to leave the cell(s) blank if the value is zero. 

o Check Show Negative Symbol to have a negative sign display in front of negative 

numbers. 

o Check Show Parenthesis to put ( ) around negative numbers. 

o Use the Color picker to make negative numbers a specific color. 
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 Date: 

o Select a time/date format. (E.g. MM-yy will display a date as 'Jun-97'). 

 

 Text format: Formatting  does not apply to cell values. 
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Border 

The Border tab allows you to alter the width and color of the cell edges. 

 

 
 Uncheck Make Borders Uniform to modify specific edges. 

 To widen the borders, enter a value (in px), or use the arrows in the width box. 

 To change the color, click the color picker and select a color, or enter a Hex value. 

Conditional Formatting/Suppression 

 

 
The Conditional tab allows you to set or modify the format of a cell based on a formula you create. 
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 Press the  Add button to create a new conditional format. Each format must have an 

Action and a Formula that evaluates to True or False. Some Actions require an Attribute 

such as a color or a number. 

 Select an Action from the dropdown. This action will occur if the formula evaluates to True. 

Actions include: 

o Foreground Color – Sets the foreground color of the cell. 

Attribute: Color 

o Background Color – Sets the background color of the cell. 

Attribute: Color 

o Font Size – Sets the size of the text. 

Attribute: Number 

o Bold – Bolds the text of the cell. 

No Attribute 

o Italic – Italicizes the text of the cell. 

No Attribute 

o Underline – Underlines the text of the cell. 

No Attribute 

o Horizontal Alignment – Aligns the text of the cell horizontally. 

Attributes: Left, Center, Right, or Justify 

o Vertical Alignment – Aligns the text of the cell vertically. 

Attributes: Top, Bottom, or Middle 

o Suppress Row – Suppresses the row the cell is in. 

No Attribute 

o Suppress Section – Suppresses the entire section that contains the cell. 

No Attribute 

o Page Break – Starts a new page. 

No Attribute 

 Press the Formula Editor Button ( ) to set the condition for the formula. 

The formula must evaluate to True or False. For conditional formatting, the Formula Editor will 

have a  Cell Value button. This button adds the function CellValue() to the formula. This 

function returns the value of the cell that conditional format is being applied to. 

 

The formula is still calculated with respect to the section of the cell. For example, for a cell in a 

report footer, the formula '{Order.Profit} > 1000' will return True if the last Order of the detail 

section profited more than 1,000. To make the condition see if the total profit was greater than 

1,000 use the formula 'Sum({Order.Profit})>1000'. 

 Use the up ( ) and down ( ) arrows to change the priority of the formats. If two formats 

share a common action and are both True, then the lower condition will be applied. 

 To remove a format, press . 
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AutoSum 

To quickly get a total on a Data Field, place the field in a Report or Group Footer and press the 

AutoSum button ( ). Alternatively, a sum can be created with the aggSum formula. See Formulas 

for more information. 

Do not use AutoSum on a cell with an aggregate formula such as aggSum. 

 

Images 

Insert an image from your computer to a cell using the Insert Image button ( ). This opens the 

Insert Image window. Select the image you would like to insert, and press  OK. 

Formulas 

Complex calculations can be done using Formulas. A formula can be added to a cell manually or 

by using the Formula Editor. To open the Formula Editor, press . 

Suppress Duplicates 

To suppress duplicate values of a Data Object from being displayed select the cell and press .  
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Charts 

Charts are a way of illustrating data in order to make it easy to spot trends and patterns. Most 

types of charts are simply a collection of points on a grid, with interstitial designs and labels that 

make them easier to read. 

By default, charts are generated dynamically, based on data points that come from Data Fields. 

Each data field can be thought of as a "series" of data, which have a common association and are 

connected in some way. When we put one data field on a chart, we have a single-series chart, 

which is useful for comparing values to each other. When we put multiple data fields on a chart, 

we have a multi-series chart, which is useful for comparing trends. 

Before creating a chart, make sure that your data exists in cells on the report. These cells don't 

have to be visible, so you can suppress them if desired. Charts are interactive in the Report Viewer, 

but will appear as static images in PDF, RTF, and Excel formats (CSV is incompatible). 

To insert a chart into a report, select a Group Footer or Report Footer cell and press the  Chart 

Wizard button. The Chart Wizard dialog will open. 

The Chart Wizard has four tabs: Type, Data, Appearance, Size and Preview. You can navigate 

between the tabs by clicking on the tab, or using the  Previous and  Next buttons. 

Type 

The Type Tab lays out all the available types of charts you can create. There are 20 types, sorted 

into five general categories. Click on a category header to see more information about that type. 

Line  

     

   

Bar and Column  

        

Pie and Other Single-Series Scatter and Bubble  

      

  

Combination Charts  
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Line 

Line charts display series of data points on a grid, connected by straight lines. They are often used 

to display a trend over time. 

Each series on a line chart is represented as a colored line. Line charts can have up to three Y-axes. 

Variations: 

 Spline chart - Data points are connected by interpolated curves instead of straight lines. 

 Area chart - The area under each line is filled in by a color. Overlapping areas have mixed 

colors. 

 Spline-Area chart - A combination of a spline chart and an area chart. 

 Spark Line chart - Has no grid or axes. Use point labels and benchmark lines for reference. 

Bar and Column 

Bar charts use rectangular bars which extend horizontally left to right to show comparisons 

between categories. Column charts use vertical bars which extend upward. The length of a bar 

represents the quantity of the data value. 

Each series on a bar or column chart is represented by a colored set of bars. 

Variations:  

 Stacked bar/column chart - Series are stacked on top of each other, additively. 

 100% Stacked bar/column chart - Series are converted to a % of the max, then stacked on 

top of each other, additively to 100%. 

 Spark column chart - Has no grid or axes. Use point labels and benchmark lines for 

reference. 

 Pareto chart - Combines a descending column chart, where each column is the next 

highest data value, and an overlapping line chart, where each point is the cumulative sum 

to that point. Often used to highlight the most important field in a series. Single-series only. 

Pie and Other Single-Series 

Pie charts are used to show the relationship of data values in a series as portions of the total. The 

area of each slice is proportional to the quantity. 

Each data value on a pie chart is represented by a colored "slice". Pie charts are single-series only. 

Variations: 

 Doughnut chart - Pie charts with a hole in the center. 

 Pyramid chart - Used to show data hierarchy in addition to value. Data values are 

represented by vertically stacked slices, the height (not width) proportional to the quantity. 

The vertical order of the slices is determined by the sort order. 
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 Funnel chart - Inverted pyramid chart. Often used to show retention amount, or stages in 

a process. Shape is inverted, not data order. To change the order, swap the sort direction. 

Scatter and Bubble 

Scatter charts use pairs of data fields with a common relation to generate coordinates as points 

on a grid. They are often used to find relationships between two variables in a set of data. Unlike 

most other report types, scatter charts often map data from detail rows, instead of group rows. 

Each series on a scatter chart is represented by a different shape and color combination. 

Variations: 

 Bubble chart - The points become circular "bubbles", with a third coordinate field as the 

radius of the bubble. 

Combination Charts 

Combination charts are several different charts layered on top of one another. They comprise a 

combination of Column, Line, Area, and/or Stacked Column charts. (Column and Stacked Column 

charts are not compatible with each other). Combination charts can have up to two Y-axes. 

Data 

The Data Tab is used to specify which cells to use as chart data. You can change how data is 

translated into points by changing the data layout. You can also choose a sort order, as well as 

upper and lower boundaries for the data and axes. 

 

Add series to the chart by selecting a Data Field containing numeric values from the Series Values 

dropdown menu. Some charts may require you to select a data field to label the X-Axis. Some 

charts may ask for two or three data fields per series. The data axis is drawn automatically. 

Data is on the Y-Axis; this may not always be the vertical axis. Labels are on the X-Axis; this may 

not always be the horizontal axis. Scatter charts have no labels axis, but have X- and Y- data axes. 
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Add additional series by pressing the  Add Series button (disabled for single-series charts). Give 

a Name to each series. Press  to remove a series. 

Change the data layout by pressing the  Data Layout... button. This will open the Data Layout 

dialog. If you change the data layout, this section will change for you to add either individual 

points, or groups of series, instead of adding individual series. See Data Layout for details. 

 

Use the Sort data by dropdown to determine how series data should be ordered: 

Report Order – Use the sort order specified by the report. 

Data Labels – Sort by the label axis value, alphabetically or numerically. 

Data Values – Sort by the value of the data. 

You can sort data in Ascending (A- Z, 0-9) or Descending (Z-A, 9-0) order. 

Use the Exclude values fields to ignore values that are too large and/or too small. 

(Grid charts) Use the Data Axis Value fields to set upper and/or lower bounds for the data axis. 

(Grid charts) Check Align Data Labels Across Series if you have multiple series with data points at 

common intervals. 

(Pie charts) Use the Other Category Percent field to group data fields with small quantities into an 

"Other" category. 

Data Layout 

Your data may not fit neatly into series. This dialog accommodates different data layouts by 

allowing you to select from a couple of different ways to build a chart. 

Column Based Chart is the default. This layout builds charts by taking data fields, and mapping 

selected values as Y-coordinates on the data axis. Determine which values are selected by 

specifying a data field with a common relation as the X-axis. This layout is useful if you want to plot 

one or more unrelated series in a group (e.g. Budget and Sales and Expenditures per Store). 
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Use Column Based Chart if... Your report contains a group with one or more elements. For example: 

 

Row Based Chart is a little more complex. This layout still uses fields as series, but all your series 

are a group, nested within another group which determines the X-axis values. Data values are 

mapped per series per group. This layout is useful if you want to plot two or more related series in 

a group (e.g. Sales per Employee per Store). 

Use Row Based Chart if...  Your report contains a group within a group. For example: 

 

If you select this layout, the data selector will change to allow you to add all your series as a group, 

nested within an outer group for the data labels: 

 

Cell Based Chart is the simplest option. This layout builds charts by taking pairs of static report 

values, and using them as (X,Y) or (label, value) coordinate pairs. 

In order for the chart wizard to recognize report cells, they must be in Formula form, with a 

preceding = sign, text surrounded by quotes, and data fields surrounded by braces { }. Examples: 

Number: =42 

Text: ="February 24th" 

Data field: ={Employees.EmployeeName} 

Formula: =Month{Orders.OrderDate} 

Math: ={Orders.UnitPrice} * 2.43 
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Use Cell Based Chart if... You want to build a chart point by point, and only have one data series. For 

example: 

 

If you select this layout, the data selector will change to allow you to add points. This layout only 

supports one series of data (duplicating data labels will create duplicate axis labels): 

 

Appearance 

The Appearance Tab contains options for customizing how the chart will look. 

Colors 

 

Use the Colors dropdown to select a color theme to apply to the chart. Specify a custom range of 

colors by selecting the Linear Range option. 

Check Use 3D Style to give your chart a three-dimensional look. 
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Labels 

 

Chart Title – Enter the text you want to appear in at the top of the chart. 

(Grid charts) X-Axis Title – Enter the text you want to appear on the X-Axis (horizontal axis). 

(Grid charts) Y-Axis Title – Enter the text you want to appear on the Y-Axis (vertical axis). 

Use the Point Labels dropdown to label the points on the chart: 

Series Values 

Percent of Series Values 

Data Labels 

Data Labels with Data Values 

Use the Legend Position dropdown to choose where to display the legend relative to the chart. 

Use the Label Font dropdown to specify the font for the labels. 

Use the  Number Format... dialog to specify how data and axis labels should be formatted: 
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(Line & combo charts) Use the  Chart Axes button to add and format axes: 

 

Press  Add Y Axis to add an additional axis. Give it a title, and use the formatting options 

to format the axis labels and data labels for associated series. Press  to remove an axis. 

Y-Axis Assignment – Use the dropdown menu for each series to associate the series with 

an axis. Each series will have the same format as the axis, and hiding an axis will hide 

associated series. 

Press  OK when done. 

Use the  Benchmark Lines... dialog to add horizontal lines at specific sections of the chart: 

 

Press  New to add a benchmark line: 
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Label – Enter the text you want to label the line. 

Value – Set the value for where the line will display. 

Color –Specify the color of the line. 

Line Style – Solid or Dashed. 

Press  to remove a benchmark line. Press  OK when done. 

Other Features 

 

This section allows you to customize a variety of attributes. The following attributes are supported: 

Font color 

Font size 

Background opacity 

Background color 

Title alignment 

Title font size 

Title on top 

Legend title 

Title font size 

Show border 

Show tooltip 

Subtitle 

Subtitle font size 

To add a customization, select an attribute from the dropdown menu and press  Add Attribute. 

Then enter a custom property into the attribute field or select from the attribute dropdown menu. 

Press  to remove a customization. 

Advanced Features 

 

This section allows an experienced user to add FusionCharts customizations. 

Recommended for advanced users only. Not all attributes may be supported. 
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See Fusion Chart Attributes for available customizations. Attributes differ depending on the type 

of chart. To see available attributes, select a chart type, then scroll down and expand a category. 

Property values generally need to be of a certain type and within a certain range. 

To add a customization, enter the attribute name, then press  Add Attribute. Then enter a 

custom property into the attribute field. 

Press  to remove a customization. 

Size and Preview 

The Size and Preview Tab allows you to change the size of the chart and preview any 

customizations. 

Chart previews in the Wizard and on the Design Grid use placeholder data. 

 

You can change the size of the chart in one of three ways: 

 Drag-and-drop the handle  at the bottom-right corner. 

 Check Fit to Cell and resize the chart cell on the Design Grid. 

 Check Set specific size and enter a custom Height and Width (in px). 

 

  

http://www.fusioncharts.com/dev/chart-attributes.html?chart=stcol3dlinedy
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GeoCharts 

GeoCharts can be displayed in a report to give a visual representation of geographic data. To 

insert a GeoChart, select a cell and press the  (GeoChart Wizard) button. The GeoChart Wizard 

has three tabs: Type, Locations, and Data. 

GeoCharts should only be placed into a Group Header, Group Footer, Report Header or Report 

Footer section. 

Type 

 
In the Type tab select the initial view, size, colors, and where to display the legend. 

 Use the Initial View dropdown to select the location that initially displays on the Map. You 

may either select the world, a continent, or a country. 

 There are three ways to set the size of the Map. 

o Enter the Height and Width in the dimension boxes. 

o Resize the chart by dragging the lower right corner in the preview. 

o Check Fit to Cell. 

 In the Colors dropdown, either select a color theme or specify a linear range of colors. 

 Check Show Legend to display the legend. 



Exago User Guide  

83 Exago Inc. 

Locations  

 

 
In the Locations Tab, specify which geographic locations should display on the Map. 

 

 Use the Location Values dropdowns to select the cells that contain the geographic 

information for the Map. To utilize Region information, such as states/provinces, Country 

information must be provided. Similarly, City information requires Region and Country 

information. 

 The Show last Location type as dropdown specifies how to display the lowest level of 

information. You can either select circular markers or shaded geographic regions. 

Data 

 
In the Data Tab, specify which data determines the color of each country/region/city and the size 

of each marker. 

For each Data Value: 

 Use the Data Values dropdown to specify which cells on the report should be used to 

determine the color and the size of each marker. Setting a cell for the size of marker is 

optional. 

 Enter a label in the Data Labels column. Labels will appear in the hover effects of Dynamic 

Maps. 

 Use the Aggregation dropdown to select a method to perform on the data: 

 

Summary 

Functions 

 Sum: Totals the all of the data in the Data Field. 

 Count: Returns the number of rows in the Data Field. 

 Average: Takes the mean of the data in the Data Field. 
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 Minimum: Displays the lowest value in the Data Field. 

 Maximum: Displays the highest value in the Data Field. 

 

 Use the Display Format dropdown to specify how to display the data: 

 

o Default: Displays the values without any formatting. 

o Currency: Prepends the currency symbol on the values. 

o Percent: Multiplies the Data Value by 100 and appends a percent symbol (%) to the 

values. 

o Scientific Notation: Displays the values in scientific notation. 

 E.g. If Decimal Places are set to 2 then 123.45 would appear as 1.23 E2. 

 

 Decimal Places: The number of decimal places to display. 

Example 

The subsequent steps show how to create a Map using the following data:  

 
The Map will be colored based on the number of customers in each location and the markers will 

be sized based on how many orders have been placed in each location. 

 

 Add a Report Footer section to the report, select all the cells in the Report Footer and press 

the merge cell button ( ). 

 Select the merged cell and press the Insert Map icon ( ). 

 In the Type tab: 

o Set the initial view, size and color. 
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 In the Locations tab, set the field Customers.Country for Country information, 

Customers.State for Region, and Customers.City for City information. Set the 'Show last 

location type as' dropdown to Markers. 

 

 

 

 In the Data tab: 

o Set the field Customers.CompanyName for Color of Locations. Provide a label such 

as 'Num. of Customers' and set the Aggregate Type to Distinct Count. 

o Set the field Orders.OrderId for the Size of Markers. Provide a label such as 'Num. 

of Orders' and set the Aggregate Type to Count. 
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 Press Finish and run the report. 
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Google Maps 

The Google Maps wizard allows you to insert interactive maps with highlighted data into your 

reports. To add a map, select a cell and press the  (Google Maps Wizard) button. Geographical 

areas can be pinpointed or highlighted dynamically depending on your report data. 

If you don't see this option, you may not have access. Please contact your administrator. Google 

Maps require an Internet connection. 

The Google Maps Wizard has four tabs: Locations, Data, Appearance, and Size and Preview. You 

can navigate between the tabs by clicking on the tab, or using the  Previous and Next  buttons. 

Locations 

 

In the Locations tab, select one or more types of locations to highlight on the map. Drag-and-drop 

a location type to the selection pane, or double-click it, or select it and press . 

Certain location types may require other types to be added, or may prevent other types from 

being added. Press  to remove a Location Type. For each Location Type, use the dropdown 

menu to select the report cell that contains the data for that type. 

County and zip code are only available in the United States. 
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Data 

 

In the Data tab, determine what metrics to see when hovering over a highlighted region. The 

Primary Metric amount is used to shade each region. Press  Add Metric to add additional 

metrics. Press  to remove a metric. 

For each Metric: 

Use the Metric dropdown menu to select the report cell that contains the data for that metric. 

Select how to aggregate the data using the Agg. Type dropdown: 

Summary 

Functions 

Sum: Totals the all of the data in the Data Field. 

Count: Returns the number of rows in the Data Field. 

Distinct Count: Returns the number of unique rows. 

Average: Takes the mean of the data in the Data Field. 

Minimum: Displays the lowest value in the Data Field. 

Maximum: Displays the highest value in the Data Field. 

 

Enter a label in the Labels field. 

Select whether it is the Primary Metric. 

Format the data type using the Number Format dialog. 
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Appearance 

 

In the Appearance tab, determine the appearance of the metrics on the map. 

Primary Metric Colors: Set the color range for region shading by either selecting a Theme, or by 

setting a Linear Range of colors. 

Metric Levels: Select which levels to calculate metrics. Select whether to display drop pins which 

will appear on city, street address, or latitude/longitude locations. 
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Size and Preview 

 

In the Size and Preview tab, determine the size, initial view, and type of map to display. 

The preview uses placeholder data values. It does not reflect the actual region shading. 

Set the initial view of the map by panning and zooming to a location. Drag-and-drop on the map 

to pan. Press the zoom buttons ( ) to zoom in or out. 

To set the size, either drag-and-drop on the lower-right handle of the map view, or check Set 

specific size and enter Height and Width values. To automatically fit the map to the report cell, 

check Fit map to cell. 

Choose the type of map by selecting the desired type from the Base Map dropdown menu. 

Press  Finish to see the completed map on the report design grid. 
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Linked Reports 

The ability to create drilldowns can be added by linking reports. Linked reports are only available 

in the Report Viewer or Dashboard Viewer. 

The Linked Report menu contains three tabs: Report, Fields, and Formula. 

 

Report 

The Report tab allows you to select which report to link to. 

 To link a report, select a cell and press the Linked Reports button . The Linked Report 

Menu will appear. Select the report you want to link and press  OK. 

 A cell with a linked report will be indicated a linked report icon . You can click on this icon 

to bring up the Linked Report Menu for this cell. 

 To unlink a report, right-click on the cell with the linked report, and select  Remove Linked 

Value. 

o Or select the cell with the linked report and open the Linked Report menu. Press  

then press  OK. 

When a link is set on a cell, by default, the unique key of the information being displayed is used to 

automatically filter the linked report. In the example below, the linked report is filtered for 

information where Employee Last Name equals 'Buchanan'. Note that report and dashboard filters 

also affect the data within drilldowns. 
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Example 

 

Fields 

By default, the application will attempt to map the field contents of the linked cell to the same field 

in the linked report. (E.g. {Categories.CategoryID} <> {Categories.CategoryID}). 

Using the Fields tab, you can specify which fields to link in order to map different fields with 

similar content. (E.g. {Categories.CategoryID } <> {Products.CategoryID}). 

 

To add a custom link: 
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 Select the category to link from the parent report in the From Category dropdown. 

 Select the category to link to within the linked report in the To Category dropdown. 

 Press  Add and select the From and To Fields for each new link. 

To remove a custom link, press . 

Formula 

The Formula tab allows you to specify a custom formula in order to further filter the data passed 

from the linked report. The formula must return True or False. The formula is evaluated for each 

row in the parent report, and if the condition is not met, the data is excluded from the linked 

report. See Formulas for more information. 

 

 To add a Data Field, drag-and-drop it into the Formula box or double-click it. Or enter it 

manually using the format: {DataCategory.DataField} 

Linked report formulas support a maximum of one data field. If multiple data fields are entered, 

all but the first will be ignored. 

 To add a Parameter, enter it manually using the format: @ParameterName@ 
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 To add a Function, drag-and-drop it into the Formula box or double-click it. Or enter it 

manually using the format: Function(variable1,variable2,...) 

Chart Drilldowns 

Chart drilldowns can also be created by using the Linked Reports menu. Chart drilldowns are only 

available in the Report Viewer or Dashboard Viewer. 

 To create a drilldown, select a cell that contains a chart and press . The Linked Report 

window will appear displaying the available reports. Select the report you want to link and 

press  OK. 

 To remove a drilldown, select the cell with the linked report and open the Linked Report 

menu. Press  then press  OK. 

Example 
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Gauges 

A Gauge can be displayed in a report to give a visual representation of the scale of a value. To 

insert a Gauge, select a cell and press the Insert Gauge button ( ). The Gauge Wizard will appear. 

The Gauge Wizard has two tabs: Appearance and Data. 

Gauges can be placed in any section of the report. 

Appearance 

 

In the Appearance tab select the Type and Dimension of the Gauge. 

 Type – Select the icon representing the type of gauge. Available types include: Angular, 

Linear, Bulb and Thermometer. 

 There are three ways to set the size of the Gauge. 

o Enter the Height and Width in the dimension boxes. 

o Resize the gauge by dragging the lower right corner in the preview. 

o Check Fit to Cell. 
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Data 

 

In the Data tab select the Data Values and Color Ranges for the Gauge. 

 Use the Value and Range dropdown to select the cell that contains the numeric value for 

the Gauge. 

 Use the Provide range as buttons to specify if the Min and Max values for the Gauge 

should be static numbers or come from cells on the report. 

 In the Color Ranges, use the Color By buttons to specify if color ranges should be 

percentages of the Max value, static numbers, or come from cells on the report. 

Percent Color Ranges must be in ascending numeric order. 

 Use the  Add and  Remove buttons to create additional colors. To change a color, 

either use the dropdown ( ) or enter a Hex value. 

Thermometer Gauges can only have one color. 
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Crosstabs  

Crosstabs allow the report to expand both horizontally and vertically based on data values and 

display summary information where each column and row meets. Crosstabs can be entered into a 

Standard Report from the toolbar using the Crosstab Button ( ). A Crosstab consists of three 

parts: Row Headers, Column Headers, and Tabulation Data. Additional settings for Crosstabs 

can be found in the Crosstab Options Menu. 

The cells below and to the right of a cell containing a Crosstab must be empty. 

 

Row Headers 

Row Headers expand a Crosstab vertically. A Crosstab has a row for each unique value of a Row 

Header. 

E.g. If you were using sales data, you may have the Row Headers Category.CategoryName and 

Products.ProductName to provide rows for each product grouped by category. 

 To add a Row Header, either drag-and-drop the Data Field to the Row Header Source 

panel or select the Data Field and press . 

 Use the Formula Editor Button ( ) to insert a formula into the Row Header. 

 Use the Edit Header button ( ) to open the header options menu. 
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In the Header Options Menu you can: 

 

 Set a Label for the Row Header. This label will appear at the top of the Crosstab. 

 Select a Sorting Method and Direction: 

 

 None – Does not sort the Row Header. 

 Header Value (Text) – Sorts the Row Header by its values as though they are 

text. 

 Header Value (Number) – Sorts the Row Header by its values as though they 

are numbers. 

 Tabular Totals – Sorts the Row Header by the totals of the Tabulation Data. 

 

If there is more than one Row Header the Header Options Menu for the top most Row Header will 

have Options for subtotals of Tabulation Data. 

 Select where to display subtotals by using the Placement dropdown: 

 

 None – Does not display subtotals. 

 Top – Displays subtotals above the Tabulation Data for each Row Header 

value. 

 Bottom – Displays subtotals below the Tabulation Data for each Row Header 

value. 

 

 Set a Label for the subtotals. 

 Use the up ( ) and down ( ) arrows to rearrange the order of the Row Headers. 

 To remove a Row Header, press the delete button ( ). 
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Column Headers 

Column Headers expand a Crosstab horizontally. A Crosstab has a column for each unique value 

of a Column Header.  

 

E.g. If you were using sales data, you may have the Column Headers 'Year({Order.OrderDate})' and 

'Month({Orders.OrderDate})' to provide columns for each month grouped by year. 

 

 To add a Column Header, either drag-and-drop the Data Field to the Column Header 

Source panel or select the Data Field and press . 

 Use the Formula Editor Button ( ) to insert a formula into the Column Header. 

 Use the Edit Header button ( ) to open the header options menu. 

 

 
 

In the Header Options Menu, you can: 

 

 Set a Label for the Column Header to appear at the top of the Crosstab. 

 Select a Sorting Method and Direction. 

 None – Does not sort the Column Header. 

 Header Value (Text) – Sorts the Column Header by its values as though they 

were text. 

 Header Value (Number) – Sorts the Column Header by its values as though 

they were numbers. 

 Tabular Totals – Sorts the Column Header by the totals of the Tabulation Data. 

 

If there is more than one Column Header the Header Options Menu for the topmost Column, 

Header will have Options for subtotals of Tabulation Data. 
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 Select where to display subtotals by using the Placement dropdown. 

 None – Does not display subtotals. 

 Left – Displays subtotals to the left of the Tabulation Data for each Column 

Header value. 

 Right – Displays subtotals to the right of the Tabulation Data for each Column 

Header value. 

 Set a Label for the subtotals. 

 Use the up ( ) and down ( ) arrows to rearrange the order of the Column Headers. 

 To remove a Column Header press . 

Tabulation Data 

Tabulation Data provides information when data exists for the Column Header and Row Header 

values. For example, if you have a Row Header on products and a Column Header on the month, 

then Tabulation Data of Orders.OrderID may use the Count function to display how many orders 

contained each product each month. 

 

 To add Tabulation Data, either drag-and-drop the Data Field to the Tabulation Data 

Source panel or select the Data Field and press . 

 Use the Formula Editor Button ( ) to insert a formula into the Tabulation Data. 

 Use the Edit Header button ( ) to open the Tabulation Options menu. 

 

 
 

In the Tabulation Options Menu, you can: 

 

 Set a Label for the Tabulation Row to appear at the beginning of each row. 

 Use the Method dropdown to select the summary function to be applied to the 

Tabulation Data. 

 

Summary 

Functions 

 Sum: Totals the all of the data in the Tabulation Data. 

 Count: Returns the number of rows in the Tabulation Data. 
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 Average: Takes the mean of the data in the Tabulation Data. 

 Minimum: Displays the lowest value in the Tabulation Data. 

 Maximum: Displays the highest value in the Tabulation Data. 

 None: Displays the value in the Tabulation Data without doing any 

calculations. 

 Use the Value dropdown to select how the Tabulation Data should be displayed. 

 

 Aggregate: Display the result of the selected Method. 

 Percent of Row: Display the result of the selected method as a percentage of 

the row total. 

 Percent of Column: Display the result of the selected method as a percentage 

of the column total. 

 

 Use the up ( ) and down ( ) arrows to move the Tabulation Data order. 

 To remove a Tabulation Data field, press . 

Crosstab Themes 

The Theme dropdown can be used to quickly style the Crosstab using one of the pre-defined 

themes. Further styling can be done to the cells of the Crosstab in the Report Designer. 

Crosstab Options 

Settings that affect the entire Crosstab are controlled in the Crosstab Options menu. 

 

Use the menu to adjust the following settings: 

General 
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 Use the Row Headers Placement dropdown to determine how the Row Headers are 

displayed. 

 Columns – Display the Row Headers in columns from left to right in their order in the 

Row Header Source panel. 

 Hierarchical – Display Row Headers in a hierarchical structure using indentation to 

display their order. 

 Check Repeat Crosstab Header every new page to repeat Row Header labels and Column 

Headers on each new page.  

Grand Total Row 

 To get a total for each column, select Top or Bottom from the Placement dropdown and 

provide a label in the Label text box. 

Grand Total Column 

 To get a total for each row, select Top or Bottom from the Placement dropdown and 

provide a label in the Label text box. 

Renaming Reports 

To change the name of a report, select 'Rename' in the Toolbar dropdown menu. Enter a new name 

and select the folder in which you want to save the report. Press  OK. 
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Changing Description 

The report description appears at the bottom of the Main Menu. Report descriptions are optional 

but can be searched. To change a report description, select 'Description' in the Toolbar dropdown 

menu. Write a description and press  OK. 

 

Changing Data Categories 

In the Categories Tab, select the Data Categories that you would like to have access to on the 

report. It is important to understand two terms: Data Category and Data Field. 

Data Category – A Data Category is a data object that has several attributes. E.g. Orders is a 

category; each order has an ID, a date, a customer, etc. 

Data Field – A Data Field is a single attribute within a category. E.g. Orders.OrderID is numeric 

value that identifies a specific order. 

 To add a Data Category, either drag-and-drop it to the selection pane, or select the 

Category and press  Add or , or double-click the Category. 

 To search for a Data Category or folder, enter text into the search bar. 

 To see the Data Fields in a Data Category, select the Category and press . 

 Check Suppress Duplicates to suppress any repeated records from that Category. 

 To remove a Data Category, press . 
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Changing Sorts 

To modify the sort criteria of a report, select 'Sorts' in the Toolbar dropdown menu. 

In the Sorts Tab, specify which Data Fields will be used to determine the order of data on the 

report. 

 To sort by a Data Field, either drag-and-drop it to the selection pane, or select the Data 

Field and press  Add or , or double-click the Category. 

 To sort by a Formula, press  Add Formula. To edit an existing formula, press . See 

Sorting by Formula for more information. 

 You can order each sort in Ascending (A-Z, 0-9) or Descending (Z-A, 9-0) order. 

 Use the up ( ) and down ( ) arrows to indicate the sort priority. 

 To remove a sort, press . 
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Sorting by Formula 

To sort and group by information that may not be contained within an individual data field, you 

can use Formulas. See Formulas for additional help. 

Press  Add Formula or the Formula Editor ( ) button to open the Formula Editor window: 
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 To add a Data Field, drag-and-drop it into the Formula box or double-click it. Or enter it 

manually using the format: {DataCategory.DataField} 

 To add a Parameter, enter it manually using the format: @ParameterName@ 

 To add a Function, drag-and-drop it into the Formula box or double-click it. Or enter it 

manually using the format: Function(variable1,variable2,...) 

For example, say I had a data field containing a full date and time, and I wanted to analyze my 

sales by each month of the year over a multi-year period. 

I could use the formula Month({Orders.OrderDate}) to return only the Month component of each 

date. Then I could sort my sales by Month. 

Changing Filters 

To modify the filter criteria of a report, select 'Filters' in the Toolbar dropdown menu. There are 

three types of filters: Standard, Interactive, and Group. Standard filters are based on values you 

specify. Interactive filters can be applied after running a report to the Report Viewer. Group filters 

are based on the minimum or maximum value in the Data Field. 

Standard Filters 

There is no limit to the number of filters that can be defined. Filters can be numeric (up to eight 

decimals) or alphanumeric. 

 To filter by a Data Field, either drag-and-drop it to the selection pane, or select the Data 

Field and press  Add or , or double-click the Data Field. 

 Use the up ( ) and down ( ) arrows to indicate the filter priority. 

 To remove a filter, press . 

 Select the operator (Equal To, Less Than, One Of, etc.) from the operator dropdown. 

 Set the filter value either by entering it manually or by selecting a value from the filter 

dropdown. If the Data Field is a date, the calendar and function buttons can be used to 

select a value. 

 Check Prompt for Value to allow the filter to be modified at the time the report is run. 

 Select AND With Next Filter to require that the selected filter and the one below it both 

evaluate to true. Select OR With Next Filter to require that either one be true. 

 Check Group With Next Filter to specify the precedence of the filters. Filters can be nested 

indefinitely by using the following keyboard shortcuts while a filter is selected: 

 Ctrl + [ adds an open-parenthesis before the selected filter. 
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 Ctrl + ] adds a close-parenthesis after the selected filter. 

 Ctrl + Shift + [ removes an open-parenthesis from before the selected filter. 

 Ctrl + Shift + ] removes a close-parenthesis from after the selected filter.  

 

 

Interactive Filters 

Interactive Filters can be created in the Report Viewer Options Menu. These filters can be enabled, 

disabled, or modified after running a report to the report viewer. For more information, see 

Interactive Report Viewer Options. 

Group (Min/Max) Filters 

Group Min/Max filters will cause the report output to display detail containing either the highest 

or lowest values in a field for either one group, multiple groups, or an entire data set. This is 

useful if you are only interested in viewing the highest or lowest values — such as the most recent 
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hire date or highest revenue figure — in a given set. Group Min/Max filters are mutually exclusive 

with standard filters, and there is no limit to the number of group filters you may define. 

 

To modify group filters, click 'Switch to Group (MIN/MAX) filters' . There is no limit to the number of 

group filters you may define. 

 

 To filter by a Data Field, either drag-and-drop it to the selection pane, or select the Data 

Field and press  Add or , or double-click the Data Field. 

 Specify Minimum or Maximum from the operator dropdown. 

 Specify whether to apply the filter to each Category or Sort field. To apply the filter to only 

the selected group, check Ignore other groupings on report. 

Selecting 'Entire Data Set' causes the Min/Max filter to apply across the entire report and ignore 

any other groupings. 

 Use the up ( ) and down ( ) arrows to indicate the filter priority. 

 To remove a filter, press the delete button ( ). 

General Options 

Hover over 'Options' in the Toolbar dropdown and then select the 'General' menu to open the 

Report Options Window. This window allows you to control various settings including default 

export type and page orientation. 
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General Options 

 Use the Default Export Type dropdown to specify the default format for the report. 

 From the Include Setup menu, select Top or Bottom to display the data categories, sorts, 

and filters at either the beginning or end of the report. 

 Output types may be disabled by unchecking the boxes for Allowed Export Types. 

 Use the Filter Execution Window dropdown to select which type of Filter menu displays 

when executing a report that has prompt-for-value filters. 

 Default – Display the default type of filter execution window. 

 Standard – Display the standard filter execution window. 

 Simple with Operator – Display a simplified filter execution window that only allows 

the operator and value to be changed. 

 Simple without Operator – Display a simplified filter window that only allows the filter 

value to be changed. 

 Check Always Show Filter Execution to show the filter menu and allow changes to be 

made each time the report is executed. 

 Use the No Data Qualify Display Mode to select what to display if no data qualifies for the 

report. 

 Show Message – Display the standard no data qualified message. 

 Show Report – Display the Page Header, Page Footer, Report Header, and Report 

Footer sections of the report. Any cells containing Data Fields will not be displayed. 

Excel Options 
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 Check Suppress Formatting to prevent the report formatting from exporting to Excel. 

Page Options 

 Specify the size for the report in the Page Size menu. Default is Letter. 

 Set the orientation for the report in the Orientation menu. Default is Portrait. 

 Check Fit to Page Width to scale all columns to fit the width of the page. 

Report Viewer Options 
 
Hover over 'Options' in the Toolbar dropdown and then select 'Report Viewer' menu to open the 

Report Viewer Options Menu. This window allows you to control what interactive capabilities a 

user has when viewing reports. 

  

General 

 
 

 Uncheck Show Grid to disable grid lines. 

 Uncheck Simulate PDF to have the report appear as though it is not on a page. 

 Uncheck Allow Hide/Show Columns on Execution to disable the Hide Columns tools. 
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Filters 

 

Interactive Filters are filters created on either Data Fields or Formulas and then enabled after 

running a report to the report viewer. 

 To filter by a Data Field, either drag-and-drop it to the selection pane, or select the Data 

Field and press  Add or , or double-click the Data Field. 

 To filter by a formula, first add a Data Field, then use the formula button ( ) to open the 

Formula Editor. 

 In the Title box provide a name for the interactive filter. 

 Use the Type dropdown to specify what kind of interactive filter to display: 

 Single Choice - A dropdown with the possible values of the filter: 
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 Multiple Choice - All possible values for the filter presented with check boxes to select 

one or more values: 

 

 
 

 Single Slider - Select the filter value by sliding a point along a scale: 

 

 
 

 Range Slider -  A scale that displays values between two points: 

 

 Press the Format button ( ) to open the format menu and specify how the filter values 

should be displayed. 

 If filtering on an Aggregate formula such as AggSum, use the Calculate Value Every 

dropdown to select on which sorted field or category the aggregate should be applied. 

 Use the Value Sort Direction to specify if the filter values should display in ascending or 

descending order. 

 Check Initially Display Filter on Panel to have the filter enabled automatically when the 

report is run to the viewer. 
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Sorts 

 

Interactive sorts can be used to change the direction of a report's Sorts while viewing the report in 

the Report Viewer 

 Uncheck Display sorts in Report Viewer to hide interactive sorts in the Report Viewer. 

 In the Title column, provide a name for each interactive sort. 

Advanced Options 

Select 'Advanced' in the Toolbar dropdown menu to open the Advanced Options window. This 

window allows you to specify additional information about how the Data Categories relate to each 

other. 
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Before using these options, it is important to understand the definition of a Join. 

Join – A join defines how two Data Categories are related. Each join has a 'From' Category and a 

'To' Category. The From and To objects must have one (or more) Data Fields that contain the same 

information. 

E.g. A join exists between two Data Categories: Orders and Customers. The join goes 'From' 

Customers 'To' Orders. In this example, when a customer makes an order, that customer's ID is 

saved with the order. Thus, the Orders Category has the Data Field CustomerID. This Data Field 

matches the Data Field CustomerID in the Customers Category. This join assures that each 

customer is paired with the orders that they have made. 

 To add a new join, press  Add. 

 To edit a join, press . 

 Restore the default joins by pressing . 

 To remove a join, press . 

 

When you press the Add or Edit buttons, the Report Join menu will appear. In this menu, you can 

create or modify a Join for the report: 

 

 To set the From Category, drag-and-drop the Data Field into the Join From panel or select 

the Data Field and press  Add From. 

 To set the To Category, drag-and-drop the Data Field into the Join To panel or select the 

Data Field and press  Add To. 

 Use the up ( ) and down ( ) Arrows to reorder the Data Fields. The position of each Field 

in Join From should match the position of its corresponding Field in Join To.  
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Document Template 

Reports can also be used to fill in PDF, RTF, or Excel templates, such as internal or government 

documents. Select 'Templates' in the dropdown menu to open the Document Template window. 

 Before using the Templates window, put your data into the cells of your report. 

 From the top dropdown, select the template you want to use. 

 In the 'Report Field' column, specify which cell of the report corresponds to each 'Template 

Field'. 

 

Once the fields are complete, exporting the report in the same format as the template will 

produce a filled-in template. 

 

The example below shows the fields being set in the Document Template window and the output 

when the report is exported as a PDF. 
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Duplicating Reports 
 

Duplicating reports can save time. This feature creates a new report that is identical to an existing 

one. Instead of creating the new report from scratch, you can duplicate an existing report, rename 

it, and make your changes. 

1. On the Main Menu, select the report you want to duplicate. 

2. Press . The Rename Report Window will open. 

3. Type the name of the new report into the Report Name field. 

4. Select which folder to save the report. 

5. Press  OK. 
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Deleting Reports  
 
Deleting a report removes the report and all of its components. 

To delete an existing report: 

1. On the Main Menu, select the report you want to delete. 

2. Press . A dialog box will ask if you are sure you want to proceed. 

3. Press  OK to delete the report. 

IMPORTANT. Once the report is deleted, there is no way to recover it. 
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Scheduling Reports  
 

Reports may be sent to recipients via email using custom scheduled intervals. A scheduled report 

can be executed and emailed immediately or scheduled to be emailed on a recurring basis. The 

Scheduler Menu lets you schedule and email reports or edit existing schedules. 

To open the Scheduler Menu: 

1. In the Main Menu, select the report you want to schedule/email. 

2. Press . The Schedule Menu will appear. 

 

 
 

 To schedule a report, press  Schedule Report. The  Schedule Report Wizard will 

open in a new tab. 

 To email a report, press  Email Report. The Email Report Menu will appear. 

 To edit existing schedules, press  Manage Scheduled Reports. The Schedule 

Manager will open in a new tab. 

If you do not see a Schedule Report button in the Main Menu, then you do not have Report 

Scheduler permissions and should contact your administrator. 

Schedule Report Wizard 

The Schedule Report Wizard has five sub tabs. The Recurrence and Recipients tabs are required, 

and the other tabs are optional. 

1. Recurrence: Specify the name and format of the report and when the report should be 

sent out. 

2. Parameters: (optional) Set values for any parameters used by the report. 

3. Filters: (optional) Add filters to the report. 
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4. Batch: (optional) Set a list of recipients each of whom will receive a unique filtered version 

of the report. 

5. Recipients: Specify the recipient addresses, subject, and body text of the email. 

Recurrence Tab 

 

In the Recurrence Tab, give the schedule a name and format. Set the frequency at which you want 

the report to be executed and sent out. This recurrence can be a one-time, daily, weekly, monthly, 

or yearly delivery. A date range can also be set to give the report delivery a defined start and end 

date. 

 Give the Schedule a Name and select an Export Type from the dropdown. 

 For PDF reports, a Password may be set. The password may require a minimum number of 

upper/lowercase letters or numbers. To find out the required password strength, hover the 

mouse over the Password box. 
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 To execute and send the report immediately, check Execute Immediately. 

 Schedule Time 

o Set the time of day the report should be executed by entering a time in the 

Schedule Time box. 

o Check Repeat every and then specify a time interval to have the schedule be sent 

on a recurring basis on the day(s) specified in as the Recurrence Pattern. 

 Recurrence Patterns 

o Once – Specify to execute the report on a specific day or immediately. 

o Daily – Send the report every weekday or every set number of days. 

o Weekly – Send the report on specific days of the week. 

o Monthly – Set the day of the month to send the report. 

o Yearly – Set the day of the year to send the report. 

 Range of Recurrence  

o Use the Range of Recurrence section to set a start date and an end date for the 

report schedule. 

Parameters Tab 

 

In the Parameters Tab, enter a value for each of the parameters listed. 

The Parameters Tab will only be visible if the report is utilizing parameters. See Parameters for 

more information. 
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Filters Tab 

 

There is no limit to the number of filters that can be defined. Filters can be numeric (up to eight 

decimals) or alphanumeric. 

 To filter by a Data Field, either drag-and-drop it to the selection pane, or select the Data 

Field and press  Add or , or double-click the Data Field. 

 Use the up ( ) and down ( ) arrows to indicate the filter priority. 

 To remove a filter, press . 

 Select the operator (Equal To, Less Than, One Of, etc.) from the operator dropdown. 

 Set the filter value either by entering it manually or by selecting a value from the filter 

dropdown. If the Data Field is a date, the calendar and function buttons can be used to 

select a value. 

 Check Prompt for Value to allow the filter to be modified at the time the report is run. 

 Select AND With Next Filter to require that the selected filter and the one below it both 

evaluate to true. Select OR With Next Filter to require that either one be true. 

 Check Group With Next Filter to specify the precedence of the filters. Filters can be nested 

indefinitely by using the following keyboard shortcuts while a filter is selected: 

 Ctrl + [ adds an open-parenthesis before the selected filter. 

 Ctrl + ] adds a close-parenthesis after the selected filter. 

 Ctrl + Shift + [ removes an open-parenthesis from before the selected filter. 

 Ctrl + Shift + ] removes a close-parenthesis from after the selected filter. 
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Batch Tab 

 

Check Run as Batch Report to enable batch execution for the report. 

If you don't see this option, your administrator may have disabled it. 

Reports can be executed and emailed en masse to a list of addresses, each one filtered by a 

unique key. E.g. A report containing data on a number of employees may be run such that each 

employee receives an email containing a version of the report filtered on their own unique ID. 

In order to use batch reporting, a table or other data structure must exist which contains a list of 

email addresses each associated with a key used to filter the report. Each row may contain 

optional columns that can be used as parameters in the email message body (using the form 

@batch_columnName@). 

Key Email Address OptionalCol1 OptionalCol2 

 

The email address table must have a join path defined to a table in the report. It does not need to 

be added to the report. 

 Enter an (optional) Batch Summary Email to send an email which will summarize the result 

of the batch report execution. 

 In the Batch Email Field select the field in the email address table which contains the 

addresses to use when sending the completed reports. 
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Recipients Tab 

 

In the Recipients Tab, determine how the schedule will be delivered and list the email address(es) 

to which the report should be sent. Separate email addresses with a semi-colon (;). 

 Check Email Results to have the report sent via email. Uncheck this option to have it saved 

to a repository. 

 An Attach Report Output to Email checkbox will be available when using batch reporting. 

Uncheck this option to prevent the reports from being attached to the recipient emails. 

 In the To field, set the email address(es) to which the report will be delivered. 

 In the Cc field, set any address(es) to be carbon copied. 

 In the Bcc field, set any address(es) to be blind carbon copied. 

When using batch reporting, the To, Cc, and Bcc fields are disabled. 

 Set the subject of the email in the Subject field. 

 In the Body field, enter the text of the email to be sent with the report. To reference the 

report name use @reportName@. To reference any batch parameters, use 

@batch_columnName@, where columnName is a column in the email address table. 

 

@reportName@ is a built-in parameter. See Parameters for more information.  
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Email Report 

Reports can be emailed quickly to a single address using the Email Report menu. 

 

In the  Scheduler Menu, hover over  Email Report. An input field will appear. 

 In the input field, enter the email address. 

 Press the  dropdown to select a format for the report. 

 Select a format to email the report. 

Reports can only be emailed as downloadable file types (Excel, PDF, RTF, CSV).  
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Manage Scheduled Reports 

Scheduled Reports can be monitored, edited, and removed using the Scheduled Reports tab. 

 

In the  Scheduler Menu press  Manage Scheduled Reports. The Scheduled Reports tab will 

open. 

 Click at the top of a column to sort the scheduled reports by that column. 

 To update the status and list new schedules press  Refresh. 

 To removed completed schedules press  Flush. 

 Press  to open the Schedule Report Wizard and modify the report. 

 To delete a schedule press . 
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Executing Reports  
 

Reports can be run or exported from the Main Menu or the Report Designer. 

In the Main Menu select the report you want to run or export. With the report highlighted press 

the Run Report button . To change the output format, press the Export Type dropdown  

and select from the available export formats (Excel, PDF, RTF, or CSV). 

Right-clicking on the Export Type button will export the report to a PDF. 

 

In the Design Tab, press the Run Report button . To change the output format, press the 

Export Type dropdown  and select from the available export formats (Excel, PDF, RTF, or CSV). 

See Report Options to change the default format for the report: 

 



Exago User Guide  

128 Exago Inc. 

Interacting with Reports 

After running a report in the Report Viewer, you can make further modifications to the report's 

style, formatting, and content. These changes can be exported to other formats, saved to the 

original report, or saved as a separate copy of the report depending on the settings. 

For these interactions to be available, they must be enabled in the Report Viewer Options Menu 

in the Report Designer. 

Changing Styling 

While viewing a report in the Report Viewer, right click a cell to open the style menu. Using this 

menu, you can change font, size, foreground and background color, bold, italic, underline, and 

alignment options. 

 

Resizing Columns 

The columns of a report can be resized by dragging the light grey bar at the top of the page to the 

desired size. 
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Applying Interactive Filters 

Any available interactive filters can be enabled by pressing the add button ( ) in the Filters 

section of the Interactive Report Viewer dock, which is located next to the report. 

Interactive filters must be defined in the Interactive Report Viewer Options Menu. Additional 

filters can be created directly on the report by right-clicking within the Report Viewer. See 

Conditional Filters for more details. 

 

After enabling a filter use the checkbox, dropdown, or slider to select what values should appear 

on the report. After selecting a value, the report will refresh with the filter applied.  

Press  to remove an active filter. The report will refresh to deactivate the filter. 

 

 

Conditional Filters 
You can set filters on specific values in addition to the pre-defined interactive filters by 

interacting with the report in the Report Viewer. 

To create a conditional filter, right-click on a cell of the report, choose an operator from the 'Apply 

To' dropdown then press the filter button ( ): 

 

The conditional filter will appear in the dock below the interactive filters and sorts: 
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Changing Sorts 

In the dock next to the report you can change the direction of any sorts on the report by pressing 

the ascending ( ) and descending ( ) buttons: 

 

 
 

Additionally, you can sort by individual columns of the report by clicking on the light grey bar at 

the top of the page: 

 

 

Hiding Columns 

In the dock next to the report, you can show/hide the columns of the report by 

checking/unchecking the column names: 

 

 

Saving & Clearing Changes 

Changes to styling, column sizes, sorts, and filters can be saved in a number of ways. 
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In the toolbar above the report: 

 Using the Clear dropdown ( ), you can remove any changes made to the report. 

 Use the Save button ( ) to save interactive changes onto the report. 

 Use the Save as New Report button ( ) to make a copy of the report with the changes. 

 Use the 'Save Changes as User Report' option under the 'Save Options' dropdown to save 

your changes as a User Report. The changes will be applied each time you run the report 

but will not be seen when the same report is run by another user. 

 Use the 'Delete User Report' option under the 'Save Options' dropdown to remove any 

changes that were saved as User Report. 

Exporting to Other Formats 

From the Report Viewer, you can export a report, including any interactive changes, to other 

formats such as Excel, PDF, RTF, or CSV. To do so, use the export button in the toolbar above the 

report and selected the export format. 
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Creating and Editing Dashboards 
 
Dashboards provide a canvas that can display reports, data visualizations, images, text and web 

pages. 

To create a new dashboard, press  (New Report) in the Main Menu, then select  Dashboard. 

The Dashboard Designer will appear in a new tab. 

 

Dashboard Designer 

The Dashboard Designer can be used to add reports, text, images, and web pages to a dashboard. 

The Dashboard Designer has four components: the Design Canvas, Tool Box, Data Fields, and 

the Toolbar. 
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Dashboard Canvas 

In the Dashboard Designer, you can: 

 Move and resize Dashboard Items 

 Style Dashboard Items with alignment, borders, colors, etc. 

 Edit Dashboard Items such as Reports, Data Visualizations, and Text 

Toolbox 

By dragging Dashboard Items from the Toolbox onto the canvas, you can add the following: 

 Reports 

 Data Visualizations 

 Text 

 Images 

 Web Pages 

 Interactive Filters 

Data Fields 
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After dragging a Data Visualization from the Toolbox on to the Canvas, you can add Data Fields by 

dragging them over the Data Visualization. 

Toolbar 

Using the toolbar, you are able to: 

 Rename the Dashboard and modify its description 

 Set the Dashboard to automatically run when entering this tool 

 Change the background color of the canvas 

 Format the font, font size, alignment, color, and borders of text 

 Save the dashboard 

 Run the dashboard to the Dashboard Viewer 
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Dashboard Items 

By dragging Dashboard Items onto the canvas, you can add the following items to the dashboard: 

 Reports 

 Dashboard Visualizations 

 Text 

 Images 

 Web Pages 

 Interactive Filters 

Adding Reports 

To add an existing report to the dashboard, drag-and-drop the Report Button ( ) over the 

Dashboard Canvas. The Report Properties menu will appear. The Report Properties menu has four 

tabs: Report, Filters, Parameters, and Options. 

Report 

In the Reports Tab, select the report you want to display on the dashboard. 
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Filters 

If the selected report has any Prompt for Value Filters, those filters will appear in the Filters tab. In 

this tab, you can specify how to prompt for these filter values. 

 

For each Filter: 

 Use the Action dropdown to select how the filter should prompt. 

o Dashboard Prompt – When the dashboard runs, you will be prompted for a value 

that is used by all of the reports on the dashboard that filter using this Data Field. 

o Report Prompt – When the dashboard runs, you will be prompted for a value to filter 

this specific report. 

o Assign Value – Assign the filter a specific value. This filter will not prompt when the 

dashboard runs. 

 In the Data (Prompt Text or Value) column, enter a value if the Action is Assign Value; if 

the Action is Dashboard or Report Prompt, enter text to use for the prompt. 

Parameters 

If the selected report has any Prompting Parameters, those parameters will appear in the 

Parameters Tab. In this tab, you can specify how to prompt for these parameter values. 
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For each Parameter: 

 Use the Action dropdown to select how the parameter should prompt. 

o Dashboard Prompt – When the dashboard runs, you will be prompted for a value 

that is to be used by all of the reports on the dashboard with that parameter. 

o Report Prompt – When the dashboard runs, you will be prompted for a value that is 

used by this specific report. 

o Assign Value – Assign the parameter a run value and do not prompt when the 

dashboard runs. 

 In the Data (Prompt Text or Value) column, enter a value if the Action is Assign Value; if 

the Action is Dashboard or Report Prompt, enter text to use for the prompt. 

 

Options 

In the Options Tab, specify settings for how the report displays on the dashboard. 

 

Report Viewer 

 In the Report Label field, provide a title for the report. This title will be displayed in on the 

canvas when editing the dashboard. 

 Check Allow scrolling to allow scrolling on the dashboard if the report is larger than the 

designated size on the canvas. 
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 Set the number of seconds at which to re-run the report. Set to 0 to only run the report 

when the dashboard is first run. 

Design 

 Check Only run report in design screen when report is manually refreshed to prevent 

the report from being run accidentally while editing the dashboard. 

Adding Data Visualizations 

To create a new Visualization on the dashboard, drag-and-drop the Data Visualization icon ( ) 

onto the Dashboard Canvas. A Data Visualization item will appear. 

 

 

 

With the Data Visualization item, you can: 

 Drag Data Fields onto the item to create a chart or a tabular report. 

 Use the Options Menu ( ) to filter, name, or modify other settings of the Visualization. 

 Modify how the Data Fields are grouped and summarized by opening the Data Model Menu 

( ). 

 Save the Data Visualization as a new Standard Report ( ). 
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Subsequent changes in the Standard Report Designer will not be reflected on the Data 

Visualization. To have those changes appear on the dashboard, add the new report to the 

dashboard. 

 Convert from a chart to tabular report (or vice versa) by selecting 'Convert to Chart' in the 

right-click menu. 

A Data Visualization must have at least two Data fields, one of which must be numeric, in order to 

display a chart. 

 

Adding Text 

To add text to the dashboard, drag-and-drop the Text icon ( ) over the Dashboard Canvas. A text 

box will appear. Type the desired text in this box. Use the Toolbar  to format the text. 

 

 

 

Adding Images 

To add an image to the dashboard, drag-and-drop the Image icon ( ) over the Dashboard 

Canvas. An image box will appear. Press the insert image button ( ) and select the image to 

upload. 
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Adding Web Pages 

To add a web page to the dashboard, drag the URL Button ( ) over the Dashboard Canvas. A 

URL menu will appear. Enter the desired URL and press . 

 

Some web pages do not permit being embedded within another web page. 

 

 
 

Adding Interactive Filters 

To add an interactive filter to the dashboard, drag-and-drop the Filter icon ( ) over the 

Dashboard Canvas. The Filter Properties menu will appear. The Filter Properties menu has two 

tabs: Dashboard Items and Filter. 

 

Dashboard Items 
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In the Dashboard Items Tab, select which reports and data visualizations the filter should apply to 

by checking the box in the Controlled column. 

All of the reports and visualizations being controlled by the filter must share at least one common 

Data Category. Interactive filters will apply to the drilldowns on selected reports. 

 

Filter 

In the Filter Tab, specify what data should be used and how the interactive filter should appear on 

the dashboard. 

 

 Use the Filter Value dropdown to select the data field that should be filtered. 

The filter can be applied to a calculation instead of a data field by using the formula button ( ). 

 Use the Type dropdown to specify what kind of interactive filter to display: 
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 Single Choice: A dropdown with the possible values of the filter. 

 

 
 

 Multiple Choice: All possible values for the filter presented with check boxes to select 

a one or more values. 

 

 
 

 Single Slider: Select the filter value by sliding a point along a scale. 

 

 
 

 Range Slider:  A scale that displays values between two points. 

 

 

 In the Style dropdown, specify if the filter should be Vertically or Horizontally oriented. 

 In the Value Sort Direction dropdown, specify if the filter values should appear from least 

to greatest (Ascending) or vice versa (Descending). 

 Press the Format button ( ) to open the format menu and specify how the filter values 

should be displayed. 

Toolbar 
 

The toolbar contains the buttons and menus used to modify the dashboard. 

Saving Dashboards 

The dashboard can be saved by pressing the save button ( ). 
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Undo/Redo 

Actions can be undone by pressing the undo button ( ) or using the keyboard shortcut Ctrl+Z. 

Undone actions can be redone by pressing the redo button ( ) or using the keyboard shortcut 

Ctrl+Y. 

Borders 

To create borders around a dashboard item, select it and press the Format icon ( ). 

 

 Uncheck Make Borders Uniform to modify specific edges. 

 To widen the borders, enter a value (in px), or use the arrows in the width box. 

 To change the color, click the color picker and select a color, or enter a Hex value. 

 

Borders can be rounded by pressing the 'Rounded Edges' button ( ) in the toolbar. 

Formatting Dashboard Text 

Text items can be formatted using buttons in the toolbar. A text item must be selected for these 

changes to be applied. 

Font 

 To change the font, use the font dropdown ( ). The font names appear in 

the style that they represent. 

 The B, I, and U icons make the font bold, italicized, and underlined, respectively. 
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 Text size can be controlled using the up and down arrows on font size menu ( ). 

Color 

 To change the text color, press the Foreground Color button (  ), and then select a color or 

enter a hex value into the Foreground box. Press the clear button ( ) to revert to the 

default color. 

 To change the background color, press the Background Color button ( ) and then select a 

color or enter a hex value into the Background box. Press the clear button ( ) to revert 

to the default color. 

Alignment 

 Text can be aligned to the top, center, or bottom of a cell using the vertical alignment 

buttons. 

 

 Text can be centered, justified, or aligned to the left or right of a cell using the horizontal 

alignment buttons. 
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Renaming Dashboards 

To change the name of a dashboard, select 'Rename' in the Toolbar dropdown menu. Modify the 

name and select the folder where the Dashboard will be saved. Press  OK. 

 

 

Changing Description 

The dashboard description appears at the bottom of the Main Menu. Dashboard descriptions are 

optional, but they are utilized when searching reports. To modify a dashboard description, select 

'Description' in the Toolbar dropdown menu. Enter a description and press  OK. 
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Dashboard Options 

Select 'Options' in the Toolbar dropdown menu to open the Dashboard Options Window. 

 

 To change the background color of the dashboard canvas, select a color or enter a hex 

value. 

 Check Show report title bar on execution to allow reports on an executed dashboard to 

be selected and modified. 

Running Dashboards 

Dashboards can be run from the Main Menu or the Toolbar. To run a dashboard from the Main 

Menu, first select the dashboard you want to run and press the 'Run Selected Report' button. 

 

 

 

When editing a dashboard, press the 'Run Dashboard' button to run the dashboard. 
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Chained Reports 
 

Chained Reports comprise multiple component reports, which run in a specified order and 

compile into a single document. 

Chained Reports can only be exported as downloadable file types (Excel, PDF, RTF, or CSV). Viewer-

only features are not supported. 

 

Chained Reports do not support Excel templates. All RTF reports in a chained report must share a 

common template. 

Chained Report Wizard 

The Chained Report Wizard is an interactive tool which allows you to create and edit Chained 

Reports. 

Navigate between the tabs by clicking on the tab, or by using the  Previous and Next  buttons. 

To save a Chained Report, press . 

The Chained Report Wizard has three sub tabs. The Name and Reports tabs must be completed. 
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Name Tab 

 

In the Name tab, enter a name and select the folder to save the report. 

The report name can be up to 255 characters long. Avoid special characters such as ? : / \ * “ < >. 

A report's description appears at the bottom of the Main Menu when it is selected. You may also 

search by a report's description text. 

You cannot create a report inside a folder that is read-only ( ). 
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Reports Tab 

 
 

In the Reports Tab, select the component reports you wish to include in the Chained Report. 

 

You can only include Standard Reports, Express Reports, and Crosstab reports in a Chained 

Report. 

 To add a component report, either drag-and-drop it to the selection pane, or select the 

report and press  Add, or double-click the report. 

 To search for a report by name or description, enter text into the search bar. 

 A component report may be able to export only in certain formats. Available formats for 

each component report are listed under Available Export Types. A Chained Report which 

contains a format restriction on a component report cannot export to that format. 

 If a component report has Prompt for Value filters or parameters, press  to access the 

Report Properties menu, where you can specify how to prompt for these filter values: 

 Common Prompt – When the Chained Report is run, you will be prompted for a value 

that is used by all of the reports on the Chained Report that have filter prompts on 

this Data Field. 

o Report Prompt – When the Chained Report executes, you will be prompted for a 

value to filter this specific component report. 
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o Assign Value – Assign the filter a specific value. This filter will not prompt when the 

Chained Report executes. 

 Use the up ( ) and down ( ) arrows to indicate the order of the reports. 

 To remove a report, press . 

Options Tab 

 

The Options Tab allows you to control various options for the chained report. 

General Options 

 Use the Default Export Type menu to specify the default format for the chained report. 

 Output types may be disabled by unchecking the boxes for Allowed Export Types. 

 Use the No Data Qualified Action menu to select what to display if no data qualifies for a 

component report. 

o Skip Report – Display the next qualified report. 

o Show Placeholder – Show a placeholder message in place of the report. 

 Check Collate Reports to enable report collation. 

Component reports must have a common sort field in order to collate. The sort field is 

used to organize the data into common groups, which determine how the chained report is 

ordered. 

With collation Disabled (default) the chained report is ordered in the following manner: 
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Filter Output 

Report 1 Page 1 

Page 2 

Report 2 Page 1 

Page 2 

 

With collation Enabled the chained report is ordered in the following manner. Note that each 

component report is filtered by the common sort group. 

Output Filter 

Report 1 Sort group 1 

Report 2 

Report 1 Sort group 2 

Report 2 

 

 Check Page break after each report to cause new reports to start on a new page. 
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Formulas 
 

Formulas allow you to do calculations, parse strings, insert images, and much more. Formulas are 

the composition of functions, parameters, Data Fields, and references to other cells. 

Functions 

Functions must begin with an '=' sign. You can use more than one function in each cell. 

Additionally, there are logical functions that allow for if/then/else conditional statements. 

Functions include date, financial, information, logical, mathematical, statistical, text, and data. 

Function names are not case sensitive (aggSum is the same as AggSum). 

For a complete list of functions, including description, remarks and examples, refer to Full 

Description of Functions. 

Parameters 

To call a parameter, enter its name between '@' signs. Parameters can be used in functions or 

alone in a cell following an '=' sign. 

Parameters are case sensitive (pageNumber is not the same as pagenumber). Parameter names 

can not contain the '@' symbol. 

For a list of parameters and their descriptions, see Full Description of Parameters. Your 

administrator has the ability to create additional parameters. 

Data Fields 

To use a Data Field as part of a function, enter its name between curly braces: 

{DataCategory.DataField} 

Referencing a Cell 

To reference another cell's value, enter the column name with a capital letter and the row number 

between square brackets (E.g. [A2]). A cell reference can be used in functions or alone in a cell 

following an '=' sign. 

Cell references will update if rows or columns are added or deleted; however, dragging a cell will 

not update cell references. This may cause errors in your formulas. 
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Using Formulas 

Formulas can either be entered in the Formula Editor or manually keyed into cells. 

Formula Editor 

1. Navigate to the Report Designer. 

2. Click in the cell in which you want the formula to appear. 

3. Press the Formula Editor Button ( ). 

 

 
 

4. Create the desired formula by selecting the desired functions and pressing  Add or by 

dragging and dropping the function into the Summary box. 

 

Embed functions beginning with the outermost function and moving inward. (E.g. To get 

=TRUNCATE(SQRT(162)), first add Truncate then the Square Root function.) 

5. Press  OK. 
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Full Description of Parameters 

 
pageNumber: 

Description 
Returns the number of the current page. 

Remark 
For RTF output, pageNumber cannot be used with other formulas.  

Example 
=@pageNumber@ will display the current page number for all output types. 

='pg. ' & @pageNumber@ will display 'pg.' followed by the page number for default 
and PDF outputs. 

NOTE. Does not work with chained reports. 

reportName: 

Description 
Returns the name of the report. 

reportFullName: 

Description 
Returns the file path of the report. 

Example 
For a report named Transcripts in a Folder named Student Documents, 
@reportFullName@ would return Student Documents/Transcripts. 

 

Quick List of Functions

Aggregate: 

 AggAvg 

 AggCount 

 AggDistinctCount 

 AggMax 

 AggMin 

 AggSum 

 

Financial: 

DB 

DDB 

Fv 

Intrate 

Ipmt 

Nper 

Npv 

Pmt 

Ppmt 

Pv 

Rate 

Sln 

Syd 

 

Date: 

Date 

DateAdd 

DateDiff 

DateValue 

Day 

Days360 

GlobalDateFormat 

GlobalDateTimeFormat 

Hour 

Minute 

Month 

Now 

Second 

Time 

TimeFormat1 

TimeValue 

Today 

Year 



Exago User Guide  

155 Exago Inc. 

Arithmetic & Geometric: 

Absolute 

Acos 

Acosh 

Asin 

Asinh 

Atan 

Atan2 

Atanh 

Ceiling 

Cos 

Cosh 

Even 

Exp 

Fixed 

Floor 

Int 

Ln 

Log 

Log10 

Mod 

Odd 

Pi 

Power 

Product 

Quotient 

Rand 

Sin 

Sinh 

Sqrt 

Tan 

Tanh 

Truncate 

 

Formatting: 

Bold 

Italic 

Underline 

String: 

Concatenate 

Left 

Len 

Lower 

Mid 

NewLine 

Replace 

Right 

Trim 

Upper 

Value 

Operators: 

& 

+ 

- 

* 

/ 

 

Logical: 

And 

False 

If 

Not 

Or 

Switch 

True 

Database & Data Type: 

IsEven 

IsLogical 

IsNonText 

IsNumber 

IsOdd 

IsText 

Null 

Type 

Other:  

CellValue 

FilterValue 

Hyperlink 

LoadImage 

StripHTMLTag 

ExcelFormula 
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Full Description of Functions 

This section provides detailed information on the available functions. 

Types of Functions: 

 Aggregate Functions 

 Logical Functions 

 Date Functions 

 Financial Functions 

 Database and Data Type Functions 

 Arithmetic and Geometric Functions 

 String Functions 

 Formatting Functions 

 Other Functions 
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Aggregate Functions 

Aggregate functions can be executed on non-numeric fields. 

AggAvg:  

Description Returns the average of the values in the field. 

Remark Only accepts Data Fields as input. 

Example E.g. aggAvg({OrderDetail.Quantity}) - returns the average quantity of sales orders. 

AggCount:  

Description Returns the number of unique entities in the Data Category. 

Remark The aggCount function uses the Data Category, not the Data Field. For example, the function 

“aggCount( {Officer.Salary} )” counts the number of Officers. You could replace “Officer.Salary” 

with any other field in the Officer Data Category and the function would still count the 

number of officers. 

 

Only accepts Data Fields as input. 

Example E.g. aggCount( {Orders.ProductPrice}) - returns the number of sales orders. 

AggDistinctCount:  

Description 
Returns the number of unique values in the Data Field. 

Remark 
Unlike aggCount, aggDistinctCount returns the number of unique values of the Data 
Field. 

 
Only accepts Data Fields as input. 

Example 
E.g. aggDistinctCount({OrderDetail.Quantity}) - returns the number distinct 
quantities in an order.  

AggMax:  

Description 
Returns the maximum value in the field. 

Remark 
Only accepts Data Fields as input. 

Example 
E.g. aggMax({OrderDetail.Discount}) - returns the largest discount. 

AggMin:  

Description 
Returns the minimum value in the field. 

Remark 
Only accepts Data Fields as input. 
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Example 
E.g. aggMin({OrderDetail.Discount}) - returns the smallest discount. 

AggSum:  

Description 
Returns the sum of the values in the field. 

Remark 
Only accepts Data Fields as input. 

Example 
E.g. aggSum({OrderDetail.Quantity}) - returns the total quantity of units 
ordered. 
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Logical Functions 

Logical functions can be used to handle conditional information. 

And:  

Description 
Returns TRUE if all its arguments are TRUE; returns FALSE if any argument is 
FALSE. 

Remark 
The arguments must evaluate to TRUE or FALSE.  

The And function can take more than two arguments as input. 

Example 
E.g. AND(2+2=4, 4+0=4, 2+3=6) – returns FALSE. 

False:  

Description 
Returns the logical value FALSE. 

Remark 
You can also type the word FALSE directly onto the worksheet or into a formula; it is 
interpreted as the logical value FALSE. 

If:  

Description 
Takes three arguments as input. Returns the second argument if the first evaluates to 
TRUE. Otherwise returns the third argument. 

Remark 
The first input must evaluate to TRUE or FALSE. 

Example 
E.g. if({OrderDetail.Price}= 0,'FREE',{OrderDetail.Price}) - returns FREE if the 

price is 0, otherwise it returns the price.  

Not:  

Description 
Reverses the value of its argument. 

Remark 
Argument should evaluate to TRUE or FALSE. 

Example 
E.g. Not(FALSE) - returns TRUE. 

Or:  

Description 
Returns TRUE if any argument is TRUE. 

Remark 
The arguments must evaluate to logical values such as TRUE or FALSE. 

The 'Or' function can take more than two arguments as input. 
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Example 
E.g. OR(2+2=4, 4+0=8, 2+3=6) - returns TRUE. 

Switch:  

Description 
This functions should be used instead of placing if() function inside of if() functions. 

Takes any even number of inputs arguments. 

Remark 
The 1st argument will be the test value to compare to. 

The 2nd argument will be returned if none of the comparisons return true. 

The 3rd, 5th, 7th… arguments will be compared to the 1st argument. When the first 
match occurs the following argument will be returned.  

For example if argument 3 matches argument 1 then the 4th argument will be 
returned.  

Example 
E.g. Switch({Categories.CategoryName},”NOT FOUND”, “Beverages”, “Drink 
up!”, “Condiments”, “Enhance”, “Confections”, “Sweet Tooth”) – returns a 
string based on the Category Name. 

True:  

Description 
Returns the logical value TRUE. 

Remark 
You can also type the word TRUE directly onto the worksheet or into a formula; it is 

interpreted as the logical value TRUE. 
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Date Functions  

Date functions can be used to do calculations and formatting on Date values.  

Date:  

Description 
Creates a date value from three numeric values. 

Remark 
This function should be used to represent a date to other functions instead of 
representing a date as text. 

Example 
E.g. Date(2012,7,4) – returns the date July 4th, 2012. 

DateAdd:  

Description 
Returns the sum of a date and a quantity of time. 

Remark 
DateAdd takes three input arguments.  

A string representing the interval you want to add. The interval can be. "yyyy" (year), 
"y" (days), "d" (days), "w" (weeks), "m" (months), "h" (hours), "n" (minutes), "s" 
(seconds), "ww" (weeks of year), or "q" (quarters).  

A real number representing how much time you want to add to the date.  

A DateValue. 

 

Example 
E.g. DateAdd('h',1,Now()) – returns the date and time 1 hour from now. 

DateDiff:  

Description 
Returns the amount of time between two dates.  

Remark 
DateDiff takes three input arguments.  

A string representing the interval you want to add. The interval can be. "yyyy" (year), 
"y" (days), "d" (days), "w" (weeks), "m" (months), "h" (hours), "n" (minutes), "s" 
(seconds), "ww" (weeks of year), or "q" (quarters).  

The first date value. 

The second date value. 

Example 
E.g. DateDiff(“yyyy”, date(1787,9,17), now())- returns the number of years 
since the signing of the United States' Constitution 

DateValue:  

Description 
Converts a date represented as text (e.g. '30-jan-2008') to a date value.  

Remark 
Any time information in the Date_text is ignored. The ticks returned always represent 
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a time-of-day of Midnight (in the server's local time). 

If the year portion of Date_text is omitted, DATEVALUE uses the current year on the 
server. 

Use this function when comparing two dates. 

Example 
E.g. DateValue(30-jun-2011) – returns the date object 6/30/2011. 

E.g. DateValue({Orders.OrderDate}) > DateValue(Today()) – compares the 
order date to today. 

Day:  

Description 
Returns the day portion of a date as a whole number. 

Remark 
Values returned by the YEAR, MONTH and DAY functions will be Gregorian 
Calendar values regardless of the display format for the supplied date value. 

Example 
E.g. Day({Appointment.Date}) - returns the day of the appointment. 

 

Day360:  

Description 
Returns the number of days between two dates based on a 360-day year.  

Remark 
Often used in accounting applications. 

Date360 takes three input arguments.  

The first date value. 

The second date value. 

Optional: True/False indicating to use European or American method of computation. 
If not included the American method is used. 

Example 
E.g. Day360({Appointment.Date},today())- returns the number of days between 
today and the appointment date. 

 

GlobalDateFormat:  

Description 
Returns a DATE value whose format is based on the session format. 

Remark 
Only accepts data objects as input. 

Example 
E.g. GlobalDateFormat({Appointment.Date})- returns the date of the 
appointment based on the session format. 

 

GlobalDateTimeFormat:  

Description Returns a DATETIME value whose format is based on the session format. 
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Remark Only accepts data objects as input. 

Example E.g. GlobalDateTimeFormat({Appointment.Date})- returns the date and time of the 

appointment based on the session format. 

Hour:  

Description Returns the hour of a time value ranging from 0 (12:00 AM) to 23 (11:00 PM).  

Remark Times may be entered as text strings within quotation marks or a date time value. 

Example E.g.  Hour("2:50:05PM") – returns 14. 

Minute:  

Description 
Returns the Minute of a time value ranging from 0 to 59.  

Remark 
Times may be entered as text strings within quotation marks or a date time value. 

Example 
E.g.  Minute("2:50:05PM") – returns 50. 

Month:  

Description 
Returns the month portion of a date as a whole number, ranging from 1 (January) to 

12 (December). 

Remark 
Values returned by the YEAR, MONTH and DAY functions will be Gregorian 
Calendar values regardless of the display format for the supplied date value. 

Example 
E.g. Month({Appointment.Date})- returns the month of the appointment. 

Now:  

Description 
Returns today's date and time (in local server time). 

Remark 
If embedding in other functions use Now('false'). 

Example 
E.g. Now() - returns the current date and time.  
Now('false') returns the current date and time formatted MM/dd/yyyy hh:mm:ss. 

Second:  

Description 
Returns the seconds of a time value ranging from 0 to 59.  

Remark 
When a time omits seconds, 0 (zero) is assumed. 

Times may be entered as text strings within quotation marks or a date time value. 

Example 
E.g.  Second("2:50:05PM") – returns 5. 

Time:  

Description 
Returns the number of ticks in a period of hours, minutes and seconds. 

Remark 
This function should be used to represent a time to other functions instead of 



Exago User Guide  

164 Exago Inc. 

representing a time as text. 

Time takes three input arguments.  
Hours 
Minutes 

Seconds 

Example 
E.g.  Time(14,50,5) – returns 534050000000. 

TimeFormat1: 

Description 
Returns the time component of a DATETIME input as a time object. 

Remark 
This function should be used to represent a time to other functions instead of 
representing a time as text. 

The return value of this function should be formatted as Text. Cells formatted as 

General or Date may contain an erroneous placeholder date. 

Example 
E.g.  Timeformat1({Appointment.Date}) – returns the time component of the 
appointment date in the format 'hh:mm tt'. 

TimeValue: 

Description 
Convert a time represented in text (i.e., “HH-mm-ss”) into time values that can be 
passed to other functions. 

Remark 
Acceptable formats include "5:55 PM" and "17:55". A time separator is mandatory 

("17:00" is acceptable, "1700" is not). 

If AM/PM is not present AM is assumed. When specifying AM or PM, do not use 
periods ("A.M." or "P.M." will return an error). 

The return value of this function should be formatted as Text. Cells formatted as 
General or Date may contain an erroneous placeholder date. 

Example 
E.g. TimeValue(Time(14,50,5)) – returns the time object 14:50:05. 

Today: 

Description 
Returns today's date with no time component. 

Remark 
If embedding in other functions use Today('false'). 

See the Now() function to get today's date with its time component. 

Example 
E.g. Today()- returns the current date. 

Today('false') returns the current date formatted as MM/dd/yyyy. 

Year: 

Description 
Returns the year portion of a date as a whole number, ranging from 1 to 9999. 

Example 
E.g.  Year(today()) – returns 2011. 
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Financial Functions 

DB:  

Description 
Returns the depreciation of an asset for a specified period using the fixed-declining 
balance method. Cost is the initial cost of the asset. Salvage is the value at the end 
of the depreciation (sometimes called the salvage value of the asset). Life is the 
number of periods over which the asset is being depreciated (sometimes called the 
useful life of the asset). Period is the period for which you want to calculate the 
depreciation. Period must use the same units as life. Month is the number of 
months in the first year. If month is omitted, it is assumed to be 12. 

Remark 
The fixed-declining balance method computes depreciation at a fixed rate. DB uses 
the following formulas to calculate depreciation for a period: (cost - total depreciation 
from prior periods) * rate where: rate = 1 - ((salvage / cost) ^ (1 / life)), rounded to 
three decimal places. Depreciation for the first and last periods is a special case. For 
the first period, DB uses this formula: cost * rate * month / 12. For the last period, 
DB uses this formula: ((cost - total depreciation from prior periods) * rate * (12 - 
month)) / 12. 

Example Data Assumptions: Initial cost=1,000,000 (A2); Salvage value=100,000 (A3); 
Lifetime in years=6 (A4).  

E.g. DB([A2],[A3],[A4],1,7) - Depreciation in first year, with only 7 months 

calculated (186,083.33).  
E.g. DB([A2],[A3],[A4],2,7) - Depreciation in second year (259,639.42).  
E.g. DB([A2],[A3],[A4],3,7) - Depreciation in third year (176,814.44). 
E.g. DB([A2],[A3],[A4],4,7) - Depreciation in fourth year (120,410.64).  
E.g. DB([A2],[A3],[A4],5,7) - Depreciation in fifth year (81,999.64).  
E.g. DB([A2],[A3],[A4],6,7) - Depreciation in sixth year (55,841.76).  
E.g. DB([A2],[A3],[A4],7,7) - Depreciation in seventh year, with only 5 months  
calculated (15,845.10). 

 DDB:  

Description 
Returns the depreciation of an asset for a specified period using the double-
declining balance method or some other method you specify. Cost is the initial cost 
of the asset. Salvage is the value at the end of the depreciation (sometimes called 
the salvage value of the asset). Life is the number of periods over which the asset 
is being depreciated (sometimes called the useful life of the asset). Period is the 
period for which you want to calculate the depreciation. Period must use the same 
units as life. Factor is the rate at which the balance declines. If factor is omitted, it is 
assumed to be 2 (the double-declining balance method).  

All five arguments must be positive numbers. 

Remark 
The double-declining balance method computes depreciation at an accelerated 

rate. Depreciation is highest in the first period and decreases in successive periods. 
DDB uses the following formula to calculate depreciation for a period: ((cost-salvage) 
- total depreciation from prior periods) * (factor/life). Change factor if you do not 
want to use the double-declining balance method. Use the VDB function if you 
want to switch to the straight-line depreciation method when depreciation is 
greater than the declining balance calculation. 

Example 
Data Assumptions: Initial cost=2400 (A2); Salvage value=300 (A3); Lifetime in 
years=10 (A4).  

E.g. DDB([A2],[A3],[A4]*365,1)  - First day's depreciation.  
E.g. DDB([A2],[A3],[A4]*12,1,2) - First month's depreciation (40.00).  
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E.g. DDB([A2],[A3],[A4],1,2) - First year's depreciation (480.00).  
E.g. DDB([A2],[A3],[A4],10) - Tenth year's depreciation.  

The results are rounded to two decimal places. 

FV:  

Description 
Returns the future value of an investment based on periodic, constant payments and 
a constant interest rate. 

Remark 
For a more complete description of the arguments in FV and for more information on 
annuity functions, see PV (Above). Rate is the interest rate per period. Nper is the 

total number of payment periods in an annuity. Pmt is the payment made each 

period; it cannot change over the life of the annuity. Typically, pmt contains principal 
and interest but no other fees or taxes. If pmt is omitted, you must include the pv 

argument. Pv is the present value, or the lump-sum amount that a series of future 
payments is worth right now. If pv is omitted, it is assumed to be 0 (zero), and you 

must include the pmt argument. Type is the number 0 or 1 and indicates when 
payments are due. If type is omitted, then it is assumed to be 0. Make sure that you 

are consistent about the units you use for specifying rate and nper. If you make 
monthly payments on a four-year loan at 12 percent annual interest, use 12%/12 for 
rate and 4*12 for nper. If you make annual payments on the same loan, use 12% for 
rate and 4 for nper. For all the arguments, cash you pay out, such as deposits to 
savings, is represented by negative numbers; cash you receive, such as dividend 
checks, is represented by positive numbers. 

Example 
Data Assumptions: Annual interest rate=6% (A2); Number of payments=10 (A3); 

Amount of the payment=-200 (A4); Present value=-500 (A5); Payment is due at the 
beginning of the period=1 (A6)...(see above).  

E.g. FV([A2]/12, [A3], [A4], [A5], [A6]) – returns future value of an investment 
with these terms (2,581.40). 

 Intrate:  

Description 
Returns the interest rate for a fully invested security.  

Dates should be entered by using the DATE function, or as results of other formulas 
or functions.  

For example, use DATE(2008,5,23) for the 23rd day of May, 2008. Problems can 
occur if dates are entered as text. Settlement is the security's settlement date. The 
security settlement date is the date after the issue date when the security is 
traded to the buyer. Maturity is the security's maturity date. The maturity date is 
the date when the security expires. Investment is the amount invested in the 
security. Redemption is the amount to be received at maturity. Basis is the type of 
day count basis to use. 

Remark 
The settlement date is the date a buyer purchases a coupon, such as a bond. The 
maturity date is the date when a coupon expires. For example, suppose a 30-year 
bond is issued on January 1, 2008, and is purchased by a buyer six months later. The 
issue date would be January 1, 2008, the settlement date would be July 1, 2008, 
and the maturity date would be January 1, 2038, which is 30 years after the January 
1, 2008, issue date. Settlement, maturity, and basis are truncated to integers. If 
settlement or maturity is not a valid date, INTRATE returns the #VALUE! error 
value. If investment = 0 or if redemption = 0, INTRATE returns the #NUM! error 
value. If basis < 0 or if basis > 4, INTRATE returns the #NUM! error value. If 
settlement = maturity, INTRATE returns the #NUM! error value. 
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Example 
Data Assumptions...Settlement date=February 15, 2008 (A2); Maturity date=May 
15, 2008 (A3); Investment=1,000,000 (A4); Redemption value=1,014,420 (A5); 
Actual/360 basis (see above)=2 (A6).  

E.g. INTRATE([A2],[A3],[A4],[A5],[A6])  - returns discount rate, for the terms of 

the bond above (0.05768 or 5.77%). 

Ipmt:  

Description 
Returns the interest payment for a given period for an investment based on periodic, 
constant payments and a constant interest rate. For a more complete description of 
the arguments in IPMT and for more information about annuity functions, see PV. 
Rate is the interest rate per period. Per is the period for which you want to find the 
interest and must be in the range 1 to nper. Nper is the total number of payment 
periods in an annuity. Pv is the present value, or the lump-sum amount that a series 
of future payments is worth right now. Fv is the future value, or a cash balance you 
want to attain after the last payment is made. If fv is omitted, it is assumed to be 0 
(the future value of a loan, for example, is 0). Type is the number 0 or 1 and 

indicates when payments are due. If type is omitted, it is assumed to be 0. 

Remark 
Make sure that you are consistent about the units you use for specifying rate and 
nper. If you make monthly payments on a four-year loan at 12 percent annual 
interest, use 12%/12 for rate and 4*12 for nper. If you make annual payments on 
the same loan, use 12% for rate and 4 for nper. For all the arguments, cash you pay 
out, such as deposits to savings, is represented by negative numbers; cash you 
receive, such as dividend checks, is represented by positive numbers. 

Example 
Data Assumptions: Annual interest=10% (A2); Period for which you want to find 

the interest=1 (A3); Years of loan=3 (A5); Present value of loan=8000 (A6).  

E.g. IPMT([A2]/12, [A3]*3, [A4], [A5]) - Interest due in the first month for a 
loan with the terms above (-22.41).  
 

The interest rate is divided by 12 to get a monthly rate. The years the money is paid 
out is multiplied by 12 to get the number of payments. 

Nper:  

Description 
Returns the number of periods for an investment based on periodic, constant 
payments and a constant interest rate. For a more complete description of the 
arguments in NPER and for more information about annuity functions, see PV 
(above). Rate is the interest rate per period. Pmt is the payment made each period; 

it cannot change over the life of the annuity. Typically, pmt contains principal and 
interest but no other fees or taxes. Pv is the present value, or the lump-sum amount 
that a series of future payments is worth right now. Fv is the future value, or a cash 
balance you want to attain after the last payment is made. If fv is omitted, it is 
assumed to be 0 (the future value of a loan, for example, is 0). Type is the number 0 
or 1 and indicates when payments are due. 

Remark 
Set Type equal to 0 (or omitted) if payments are due at the end of the period; Set 
type equal to 1 if payments are due at the beginning of the period. 

Example 
Data Assumptions: Annual interest rate=12% (A2); Payment made each period=-
100 (A3); Present Value=-1000 (A4); Future Value=10000 (A5); Payment is due at 
the beginning of the period=1 (A6).  

E.g. NPER([A2]/12, [A3], [A4], [A5], 1) - Periods for the investment with the 
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above terms (60).  
E.g. NPER([A2]/12, [A3], [A4], [A5]) - Periods for the investment with the above 
terms, except payments are made at the beginning of the period (60).  
E.g. NPER([A2]/12, [A3], [A4]) - Periods for the investment with the above terms, 

except with a future value of 0 (-9.578). 

Npv:  

Description 
Calculates the net present value of an investment by using a discount rate and a 
series of future payments (negative values) and income (positive values). Rate is the 
rate of discount over the length of one period. Value1, value2, ...are 1 to 29 
arguments representing the payments and income. Value1, value2, ...must be equally 
spaced in time and occur at the end of each period. NPV uses the order of value1, 
value2, ...to interpret the order of cash flows. Be sure to enter your payment and 
income values in the correct sequence. Arguments that are numbers, empty cells, 
logical values, or text representations of numbers are counted; arguments that are 
error values or text that cannot be translated into numbers are ignored. If an 

argument is an array or reference, then only numbers in that array or reference are 
counted. Empty cells, logical values, text, or error values in the array or reference are 
ignored. 

Remark 
The NPV investment begins one period before the date of the value1 cash flow and 
ends with the last cash flow in the list. The NPV calculation is based on future cash 
flows. If your first cash flow occurs at the beginning of the first period, the first value 
must be added to the NPV result, not included in the values arguments. For more 
information, see the example below. NPV is similar to the PV function (present 
value). The primary difference between PV and NPV is that PV allows cash flows to 
begin either at the end or at the beginning of the period. Unlike the variable NPV 

cash flow values, PV cash flows must be constant throughout the investment. For 
information about annuities and financial functions, see PV. NPV is also related to the 
IRR function (internal rate of return). IRR is the rate for which NPV equals zero: 
NPV(IRR(...), ...) = 0. 

Example 
Data Assumptions: Annual discount rate=10% (A2); Initial cost of investment one 
year from today=-10,000 (A3); Return from first year=3,000 (A5); Return from 
second year=4,200 (A6). 

E.g. NPV([A2], [A3], [A4], [A5], [A6]) - Net present value of this investment 
(1,188.44) ...In the preceding example, you include the initial $10,000 cost as one of 

the values, because the payment occurs at the end of the first period. 

Pmt:  

Description 
Calculates the payment for a loan based on constant payments and a constant 
interest rate. For a more complete description of the arguments in PMT, see the PV 
function. Rate is the interest rate for the loan. Nper is the total number of payments 
for the loan. Pv is the present value, or the total amount that a series of future 
payments is worth now; also known as the principal. Fv is the future value, or a cash 
balance you want to attain after the last payment is made. If fv is omitted, it is 
assumed to be 0 (zero), that is, the future value of a loan is 0. Type is the number 0 
(zero) or 1 and indicates when payments are due. 

Remark 
The payment returned by PMT includes principal and interest but no taxes, reserve 
payments, or fees sometimes associated with loans. Make sure that you are 
consistent about the units you use for specifying rate and nper. If you make monthly 
payments on a four-year loan at an annual interest rate of 12 percent, use 12%/12 
for rate and 4*12 for nper. If you make annual payments on the same loan, use 12 
percent for rate and 4 for nper. 

Example 
Data Assumptions: Annual interest rate=8% (A2); Number of months of 
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payments=10 (A3); Amount of loan=10000 (A4). 

E.g. PMT([A2]/12, [A3], [A4]) - Monthly payment for a loan with the above terms 
(-1,037.03). 
E.g. PMT([A2]/12, [A3], [A4], 0, 1) - Monthly payment for a loan with the above 

terms, except payments are due at the beginning of the period (-1,030.16). 

Ppmt:  

Description 
Returns the payment on the principal for a given period for an investment based on 
periodic, constant payments and a constant interest rate. For a more complete 
description of the arguments in PPMT, see PV (above). Rate is the interest rate per 
period. Per specifies the period and must be in the range 1 to nper. Nper is the total 
number of payment periods in an annuity. Pv is the present value—the total amount 
that a series of future payments is worth now. Fv is the future value, or a cash 
balance you want to attain after the last payment is made. If fv is omitted, it is 
assumed to be 0 (zero), that is, the future value of a loan is 0. Type is the number 0 
or 1 and indicates when payments are due. 

Remark 
Make sure that you are consistent about the units you use for specifying rate and 
nper. If you make monthly payments on a four-year loan at 12 percent annual 
interest, use 12%/12 for rate and 4*12 for nper. If you make annual payments on 
the same loan, use 12% for rate and 4 for nper. 

Example 
Data Assumptions: Annual interest rate=10% (A2); Number of years in the loan=2 
(A3); Amount of loan=2000 (A4). 
E.g. PPMT([A2]/12, 1, [A3]*12, [A4]) - Payment on principle for the first month 
of loan (-75.62).  
 

The interest rate is divided by 12 to get a monthly rate. The number of years the 
money is paid out is multiplied by 12 to get the number of payments. 

Pv:  

Description 
Returns the present value of an investment. The present value is the total amount 
that a series of future payments is worth now. For example, when you borrow money, 
the loan amount is the present value to the lender. Rate is the interest rate per 
period. For example, if you obtain a car loan at a 10% annual interest rate and make 
monthly payments, your interest rate per month is 10%/12, or 0.83%. You would 
enter 10%/12, or 0.83%, or 0.0083, into the formula as the rate. Nper is the total 
number of payment periods in an annuity. For example, if you get a four-year car loan 

and make monthly payments, your loan has 4*12 (or 48) periods. You would enter 48 
into the formula for nper. Pmt is the payment made each period and cannot change 
over the life of the annuity. Typically, pmt includes principal and interest, but no other 
fees or taxes. For example, the monthly payments on a $10,000, four-year car loan 
at 12 percent are $263.33. You would enter -263.33 into the formula as the pmt. If 
pmt is omitted, you must include the fv argument. Fv is the future value, or a cash 
balance you want to attain after the last payment is made. If fv is omitted, then it is 
assumed to be 0 (the future value of a loan, for example, is 0). For example, if you 
want to save $50,000 to pay for a special project in 18 years, then $50,000 is the 
future value. You could then make a conservative guess at an interest rate and 
determine how much you must save each month. If fv is omitted, then you must 
include the pmt argument. Type is the number 0 or 1 and indicates when payments 

are due. 

Remark 
Make sure that you are consistent about the units you use for specifying rate and 
nper. If you make monthly payments on a four-year loan at 12 percent annual 
interest, use 12%/12 for rate and 4*12 for nper. If you make annual payments on 
the same loan, use 12% for rate and 4 for nper. In annuity functions, cash you pay 
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out, such as a deposit to savings, is represented by a negative number; cash you 
receive, such as a dividend check, is represented by a positive number. For example, 
a $1,000 deposit to the bank would be represented by the argument -1000 if you are 
the depositor and by the argument 1000 if you are the bank. 

Example 
Data Assumptions: Money paid out of an insurance annuity at the end of every 
month=500 (A2); 8% is the interest rate earned on the money paid out (A3); 20 is 
the number of years the money will be paid out (A4). 
E.g. Pv([A3]/12, 12*[A4], [A2], , 0) - Present value of an annuity with the stated 
terms (-59,777.15). The result is negative because it represents money that you 
would pay in an outgoing cash flow. If you are asked to pay ($60,000) for the 
annuity, you would determine this would not be a good investment because the 
present value of the annuity (59,777.15) is less than what you are asked to pay.  

The interest rate is divided by 12 to get a monthly rate. The years the money is paid 
out is multiplied by 12 to get the number of payments. 

Rate:  

Description 
Returns the interest rate per period of an annuity. RATE is calculated by iteration and 
can have zero or more solutions. If the successive results of RATE do not converge to 
within 0.0000001 after 20 iterations, RATE returns the #NUM! error value. For a 
complete description of the arguments nper, pmt, pv, fv, and type, see PV. Nper is 
the total number of payment periods in an annuity. Pmt is the payment made each 
period and cannot change over the life of the annuity. Typically, pmt includes principal 
and interest but no other fees or taxes. If pmt is omitted, you must include the fv 
argument. Pv is the present value—the total amount that a series of future payments 
is worth now. Fv is the future value, or a cash balance you want to attain after the 
last payment is made. If fv is omitted, it is assumed to be 0 (the future value of a 

loan, for example, is 0). Type is the number 0 or 1 and indicates when payments are 
due. 

Remark 
Guess is your guess for what the rate will be. If you omit guess, it is assumed to be 
10 percent. If RATE does not converge, try different values for guess. RATE usually 
converges if guess is between 0 and 1. Make sure that you are consistent about the 
units you use for specifying guess and nper. If you make monthly payments on a 
four-year loan at 12 percent annual interest, use 12%/12 for guess and 4*12 for 
nper. If you make annual payments on the same loan, use 12% for guess and 4 for 
nper. 

Example 
Data Assumptions: Years of the loan=4 (A2); Monthly payment=-200 (A3); Amount 
of the loan=8000 (A4). 
E.g. Rate([A2]*12, [A3], [A4]) - Monthly rate of the loan with the stated terms 
(1%). 

The number of years of the loan is multiplied by 12 to get the number of months. 

Sln:  

Description 
Returns the straight-line depreciation of an asset for one period. 

Remark 
Cost is the initial cost of the asset. Salvage is the value at the end of the 
depreciation (sometimes called the salvage value of the asset). Life is the number of 
periods over which the asset is depreciated (sometimes called the useful life of the 
asset). 



Exago User Guide  

171 Exago Inc. 

Example 
Data Assumptions: Cost=30,000 (A2); Salvage value=7,500 (A3); Years of useful 
life=10 (A4). 
E.g. Sln([A2], [A3], [A4]) - The depreciation allowance for each year (2,250). 

Syd:  

Description 
Returns the sum-of-years' digits depreciation of an asset for a specified period. 

Remark 
Cost is the initial cost of the asset. Salvage is the value at the end of the 
depreciation (sometimes called the salvage value of the asset). Life is the number of 
periods over which the asset is depreciated (sometimes called the useful life of the 
asset). Per is the period and must use the same units as life. 

Example 
Data Assumptions: initial cost=30,000 (A2); Salvage value=7,500 (A3); Lifespan in 
years=10 (A4). 
E.g. Syd([A2], [A3], [A4], 1) - Yearly depreciation allowance for the first year 
(4,090.91). 

E.g. Syd([A2], [A3], [A4], 10) - Yearly depreciation allowance for the tenth year 
(409.09). 
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Database & Data Type Functions 

DataRowCount:   

Description 
Returns the number of rows retrieved from the data source when executing the 
report. 

Example 
Suppose report is run to retrieve basic information on 10 employees 

E.g. DataRowCount() should return 10. 

IsEven:  

Description 
Checks if a value is an even number. 

Example 
E.g. IsEven([A1]) – returns TRUE if the cell [A1] contains an even number, FALSE 
otherwise. 

IsLogical:  

Description 
Checks if a value is TRUE or FALSE. 

Example 
E.g. IsLogical([A1]) – returns TRUE if the cell [A1] contains TRUE/FALSE, FALSE 
otherwise. 

IsNonText:  

Description 
Checks if a value is not text. 

Remark 
Non Text values include dates, numbers, images and blank cells. 

Example 
E.g. IsNonText([A1]) – returns TRUE if the cell [A1] contains non text, FALSE 
otherwise. 

IsNoDataQualified:   

Description 
Returns True if no data qualified for the report execution. Otherwise it returns false. 

Example 
Suppose report is run to retrieve basic information on 10 employees 

E.g. IsNoDataQualified() returns false. 

IsNumber:  

Description 
Checks if a value is a number. 

Remark 
Does not convert text to numbers. Ex IsNumber(“19”) returns FALSE. 

Example 
E.g. IsNumber([A1]) – returns TRUE if the cell [A1] contains a number, FALSE 
otherwise. 

IsOdd:  
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Description 
Checks if a value is odd. 

Example 
E.g. IsOdd([A1]) – returns TRUE if the cell [A1] contains an odd number, FALSE 

otherwise. 

IsText:  

Description 
Checks if a value is text. 

Example 
E.g. IsText([A1]) – returns TRUE if the cell [A1] contains text, FALSE otherwise. 

Null:  

Description 
Returns a null value (Nothing in VB). 

Type:  

Description 
Returns the type of value. 

Remark 
Returns 1 if the value is a number, 2 if it is text. 

Example 
E.g. Type(“John Smit”) – returns 2. 
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Arithmetic & Geometric Functions 

Abs:  

Description 
Returns the absolute value of a number. 

Example 
E.g. Abs(-23.1) – returns 23.1. 

Acos:  

Description 
Returns the arccosine, or inverse cosine, of a number.  

Remark 
The input must be from -1 to 1. 
 
The returned angle is given in radians in the range 0 (zero) to pi. If you want to 
convert the result from radians to degrees, then multiply it by 180/PI() or use 
the DEGREES function. 

Example 
E.g. Acos(-.231) – returns 1.80390168255052. 

Acosh:  

Description 
Returns the inverse hyperbolic cosine of the given number. 

Remark 
The input must be a real number greater than or equal to 1. 

Example 
E.g. Acosh(10) – returns 2.993223. 

Asin:  

Description 
Returns the arcsine of the given number in radians, in the range -Pi/2 to Pi/2. 

Remark 
The input is the sine of the angle you want and must be in the range from -1 to 1. 

Example 
E.g. Asin(-0.5) – returns 0.5236. 

Asinh:  

Description 
Returns the inverse hyperbolic sine of a number.  

Remark 
The input can be any real number. 

asinh(sinh(n)) returns n.  

Example 
E.g. Asinh(-2.5) – returns -1.64723. 

Atan:  

Description 
Returns the arctangent, inverse tangent of a number.  

Remark 
The input can be any real number. 
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Atan returns an angle given in radians in the range -Pi/2 to Pi/2. 

Example 
E.g. Atan(1) – returns 0.785398 (pi/4). 

Atan2:  

Description 
Returns the angle from the x-axis to a line containing the origin (0, 0) and a point 
with coordinates (x,y). 

Remark 
The input requires two values, the x and y coordinates.  

If both x,y are 0, then Atan2 will return the error #Div/0! 

A negative result represents a clockwise angle.  

Example 
E.g. Atan2(1, 1) – returns 0.785398 (pi/4). 

Atanh:  

Description 
Returns the inverse hyperbolic tangent of a number. 

Remark 
The input must be from -1 to 1. 
 
Atanh(tanh(n)) returns n. 

Example 
E.g. Atanh(.76159416) – returns 1 (approximately). 

Ceiling:  

Description 
Returns the number rounded up, away from zero, to the nearest multiple of 
significance. 

Remark 
The input requires two values, the number to be rounded and the multiple of 
significance. 

Regardless of the sign of number, a value is rounded up when adjusted away from 
zero. 

If the argument is non-numeric, then Ceiling returns the error #VALUE! 

Example 
E.g. Ceiling(4.42,.05) – returns 4.45. 

Cos:  

Description 
Returns the cosine, of an angle in radians. 

Remark 
The returned angle is given in radians in the range 0 (zero) to pi. If you want to 
convert the result from radians to degrees, then multiply it by 180/PI() or use 
the DEGREES function. 

Example 
E.g. Cos(1.047) – returns 0.500171. 

Cosh:  



Exago User Guide  

176 Exago Inc. 

Description 
Returns the hyperbolic cosine of a number. 

Example 
E.g. Cos(4) – returns 27.30823.  

Even:  

Description 
Returns a number rounded up to the nearest even integer. 

Remark 
Regardless of the sign of number, a value is rounded away from zero. 

If the number is non-numeric, then EVEN returns the error #VALUE! 

Example 
E.g. Even(1.5) – returns 2.  

Exp:  

Description 
Returns e raised to the power of the input. 

Remark 
Exp is the inverse of Ln, the natural logarithm. 

Example 
E.g. Exp(1) – returns 2.718282 (the approximate value of e). 

Fixed:  

Description 
Returns the first argument rounded to the number of decimal places specified in the 
second argument. 

Remark 
Takes three input values: 

1. The number you want to round. 
2. The number of digits to the right of the decimal to include. 
3. (Optional) TRUE/FALSE whether to omit commas. The default is FALSE (includes 
commas as normal). 

Example 
E.g. Fixed(1234.5678, 2) – returns 1,234.56. 

Floor:  

Description 
Rounds the number down, toward zero, to the nearest multiple of significance. 

Remark 
The input requires two values, the number to be rounded, and the multiple of 
significance. 

Regardless of the sign of number, a value is down toward zero. 

If the argument is non-numeric, then Floor returns the error #VALUE! 

Example 
E.g. Floor(2.6, .5) – returns 2.5. 

Int:  

Description 
Rounds a number down to the nearest integer. 
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Remark 
The input must be a real number.  

Example 
E.g. Int(2.6) – returns 2. 

Ln:  

Description 
Returns the natural logarithm of a number. 

Remark 
LN is the inverse of the EXP function. 

Example 
E.g. Ln(86) – returns 4.454347. 

Log:  

Description 
Returns the logarithm of a number to the base you specify. 

Remark 
The first input is the number and the second is the base (if omitted base 10 used).  

Example 
E.g. Log(100) – returns 2. 

Log10:  

Description 
Returns the base 10 logarithm of a number. 

Example 
E.g. Log10(86) – returns 1.934498451. 

Mod:  

Description 
Returns the remainder after first argument is divided by the second argument. 

Remark 
The second argument must not be 0.  

Example 
E.g. Mod(27,5) – returns 2. 

Odd:  

Description 
Returns a number rounded up to the nearest odd integer. 

Remark 
The input must be a real number. Odd always rounds away from zero.  

Example 
E.g. Mod(1.5) – returns 3. 

Pi:  

Description 
Returns the number 3.14159265358979, the mathematical constant pi, accurate to 
15 digits. 

Example 
E.g. Pi() – returns 3.14159265358979. 

Power:  
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Description 
Returns the result of the first argument raised to the second argument. 

Remark 
The operator ^ may be used instead of this function. 

Example 
E.g. Power(5,2) – returns 25. 

Product:  

Description 
Returns the product of the arguments. 

Remark 
The * symbol may be used in place of product. 

Arguments must be numbers, cell references or text representations of numbers.  

Example 
E.g. Product(5,2) – returns 10. Also 5 * 2 - returns 10. 

Quotient:  

Description 
Returns the integer portion of a division. 

Remark 
The / symbol may be used in place of product. 

This function discards the remainder of the division. 

Example 
E.g. Quotient(5,2) – returns 2. Also 5/2 – returns 2. 

Rand:  

Description 
Returns an evenly-distributed random number between 0 and 1 (inclusive). 

Remark 
To generate a random real number between a and b, use: RAND()*(b-a)+a. 

Example 
E.g. Rand() – returns a random number between 0 and 1. 

Round:  

Description 
Returns a rounded number. 

Remark 
Takes one or two input: 

The number to round. 
2.  The number of decimal places desired. 

Example 
E.g. Round(5.236, 2) – returns 5.24 

RunningSum:  

Description 
Returns a running total of the input field. 

Remark 
Takes one or two input: 

The Data Field you want to sum. 
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2. OPTIONAL: A Data Field or Category. The running sum will reset to 0 whenever 
there is a new value for this Data Field or Category. 

RunningSum should not be used with the AutoSum feature. 

Example 
E.g.  

1. RunningSum({Employees.Salary}) – returns running total of all the employee's 
salary. 

2. RunningSum({Employees.Salary}, {Employees.Region}) – returns a running 
total of employee's salary for each region. 

3. RunningSum({Employees.Salary}, {Company}) – returns a running total of 
employee's salary for each Company. 

Sin:  

Description 
Returns the sine of the given angle. 

Remark 
The returned angle is given in radians in the range 0 (zero) to pi. If you want to 
convert the result from radians to degrees, then multiply it by 180/PI() or use 
the DEGREES function. 

Example 
E.g. Sin(1.047) – returns .0865926611287823. 

Sinh:  

Description 
Returns the hyperbolic sine of a number. 

Example 
E.g. Sinh(4) – returns 27.1899171971278. 

Sqrt:  

Description 
Returns the positive square root of the argument. 

Remark 
If the input is negative Sqrt returns the error #NUM!. 

Example 
E.g. Sqrt(25) – returns 5. 

Tan:  

Description 
Returns the tangent of the given angle. 

Remark 
The returned angle is given in radians in the range 0 (zero) to pi. If you want to 
convert the result from radians to degrees, then multiply it by 180/PI() or use 
the DEGREES function. 

Example 
E.g. Tan(.785) – returns .99920. 

Tanh:  

Description 
Returns the hyperbolic tangent of a number. 
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Example 
E.g. Tanh(-2) – returns .96403. 

Truncate:  

Description 
Truncates a number to an integer by removing the fractional part of the number. 

Remark 
INT and TRUNC are different only when using negative numbers: TRUNC (-4.3) 
returns -4, but INT (-4.3) returns -5 because -5 is the lower number. 

Example 
E.g. Truncate(9.9) – returns 9. 
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String Functions 

Concatenate:  

Description 
Joins several text strings into one text string. 

Remark 
The "&" operator can be used instead of CONCATENATE to join text items. 

Example 
E.g. Concatenate(“This “, “is “, “one string!” ) – returns This is one string! 

Left:  

Description 
Returns the first character(s) of a text string. 

Remark 
The first argument is the string you want to display. The second argument is number 
of characters you want. 

Example 
E.g. Left(“example”, 2 ) – returns E.g. 

Len:  

Description 
Returns the number of characters in a text string. 

Example 
E.g. Len(“example” ) – returns 7. 

Lower:  

Description 
Converts all uppercase letters in a text string to lowercase. 

Example 
E.g. Lower(“EXAMPLE” ) – returns example. 

Mid:  

Description 
Returns a specific number of characters from a text string starting where you specify.  

Remark 
Mid takes three input arguments: 

1. The text string. 
2. The place you want to start. 
3. The number of characters you want to display. 

Example 
E.g. Mid(“example” , 2, 3) – returns xam. 

NewLine:  

Description 
Begins a new line of text. 

Replace:  

Description 
Replaces part of a text string.   

Remark 
Replace takes four input arguments: 
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1. The text string to partially replaced. 
2. The place you want to start replacing. 
3. The number of characters to replace. 
3. The string you want to substitute.  

Example 
E.g. Replace("example", 2, 3, "*") – returns e*ple. 

Right:  

Description 
Returns the last characters in a text string. 

Remark 
The first argument is the string you want to display. The second argument is number 
of characters you want. 

Example 
E.g. Right("example", 2) – returns le. 

Trim:  

Description 
Removes all spaces from text except for single spaces between words. 

Example 
E.g. Trim("This     sentence     has   weird    spacing.", 2) – returns This 
sentence has weird spacing. 

Upper:  

Description 
Converts text to uppercase. 

Example 
E.g. Upper("example") – returns EXAMPLE. 

Value:  

Description 
Converts a text string that represents a number to a number. 

Example 
E.g. Value("$1,000") – returns 1000. 
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Formatting Functions 

Bold:  

Description 
Applies the bold formatting to the input. 

Remark 
Can be used to bold part but not all of the text in a cell. 

An entire cell can be made bold using the bold button in the toolbar or ctrl + B. 

Example 
E.g. ='The second half of '& bold('this sentence is bold.') – returns 'The second 

half of this sentence is bold.'  

Italic:  

Description 
Applies the italic formatting to the input. 

Remark 
Can be used to italic part but not all of the text in a cell. 

An entire cell can be italicized using the italic button in the toolbar or ctrl + I. 

Example 
E.g. = 'The second half of '&italic ('this sentence is italic.') – returns 'The 
second half of this sentence is bold.'  

Underline:  

Description 
Applies the underline formatting to the input. 

Remark 
Can be used to underline part but not all of the text in a cell. 

An entire cell can be underlined using the underline button in the toolbar or ctrl + U. 

Example 
E.g. = 'The second half of '&underline ('this sentence is underlined.') – 
returns 'The second half of this sentence is underlined.'  
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Other Functions 

CellValue:   

Description 
Returns the value of the current cell. 

Remark 
This function is only used in Conditional Formatting. 

Example 
Suppose a cell of a report displays the price of products.  

E.g. CellValue()>150 returns True if the price of the product is greater than 150. 

FilterValue:   

Description 
Returns the current value of a filter. 

Remark 
Takes three arguments. 
1. The index of the filter. 
2. The sub-index used for filters that contain multiple values (i.e. between or one of). 
3. (Optional) a true/false indicator if the value should be formatted following the 
user's culture settings. This is used for numbers and dates.    

If there are no filters the function will return an Index out of Range message. 

Indexes begin with 1. 

Example 
Suppose the filter summary is “Order Detail.UnitPrice > '3.6' and 
Products.ProductName is one of ('Boston Crab Meat', 'Tofu')”. 

E.g. FilterValue(2,2) returns Tofu. 

Hyperlink:   

Description 
Creates a hyperlink to an external website. 

Remark 
Takes two arguments. 

1. The URL of the website. 

2. (Optional) the text to display in the cell. 

If display text is omitted, the URL will display. 

If PDF exports open in a tab within this application, then clicking the hyperlink may 
direct a user to leave the application. 

Example 
E.g. Hyperlink('www.fakeWebSite.com', 'click here') returns a hyperlink that 
displays the text 'click here' . Clicking this text will open 
http://www.fakeWebSite.com. 

LoadImage:   

Description 
Loads a server side image based on the input path into the cell. 
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Remark 
Can be used to load an image dynamically in place of the insert image feature. The 
path to the image must be in quotation marks. The entire path of the image is not 
required if your administrator has set a 'LoadImage' Prefix. Can also be used to load 
images stored in a database by using a data field as the function's argument (without 

quotes). 

Example 
E.g. LoadImage("C:/StarryNight.jpg") 

E.g. LoadImage({Categories.Picture}) 

StripHtmlTags:   

Description 
Removes any HTML tags from the input string. 

Remark 
The input must be a string in between quotation marks. 

Example 
E.g. StripHtmlTags("<h1>This is heading 1</h1>") returns This is heading 1. 

ExcelFormula:   

Description 
Passes an Excel formula to an Excel report.. 

Remark 
The input must be a string in between quotation marks. 

Example 
E.g. ExcelFormula("SUM(A1:A100)") will pass the formula SUM(A1:A100) to 
Excel, which will evaluate the formula when the spreadsheet is opened. 
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User Preferences 

If given permission by your administrator, the User Preferences button will appear in the top right 

corner. Press the User Preferences button ( ) to open the User Preferences menu. 

 

Startup Reports 

In the User Preferences menu, set your preferences such as which reports should run at startup 

and/or what User Reports should be applied. 

 

 To filter a report, either drag-and-drop it to the selection pane, or select the report and 

press  Add, or double-click the report. 

 To disable a user report, press . 

Context Sensitive Help 

Context sensitive help is available at any point in the application. Press the help button ( ), and 

documentation will appear in a new tab. The guide will automatically open to the section that 

reflects the feature you are using. 
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